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In this Guide ...
 In this Guide ... 

This document provides instructions for installation, configuration, 
administration, and maintenance of an OpenLAB CDS Workstation. It 
includes information on the license generation with SubscribeNet.

1 Install OpenLAB CDS Workstation
This chapter describes the installation of the software.

2 Post Installation Tasks
This chapter describes tasks that are relevant after finishing the installation.

3 Licensing
This chapter provides basic information on licensing. It describes how you 
generate a license file with SubscribeNet and install the license in the Control 
Panel.

4 Configure OpenLAB CDS Workstation
This chapter describes the initial configuration steps after installing the 
software. For more details, refer to the Control Panel section in OpenLAB 
Help & Learning.

Table 1 Terms and abbreviations used in this document

Term Description

Control Panel Control Panel for Agilent OpenLAB software

Microsoft Control Panel Part of the Microsoft Windows operating 
system

Shared Services Set of administrative services that control, for 
example, the security policy and the central 
configuration of OpenLAB CDS. Shared 
services are accessed via the Control Panel.
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In this Guide ...
5 Optional Procedures
This chapter describes the installation or upgrade of additional instrument 
driver software. It also contains information on the installation of OpenLAB 
Help and Learning only, and on performance improvement on offline 
machines. 

6 About the OpenLAB CDS Software
This chapter contains an overview of the software architecture and 
customization options.

7 System Setup and Maintenance
This chapter contains information on the Control Panel and Shared Services 
Maintenance. In addition, it describes various maintenance procedures.

8 Upgrade OpenLAB CDS
This chapter describes the upgrade from OpenLAB CDS 2.0 or OpenLAB CDS 
2.1 to the current version of OpenLAB CDS.

9 Uninstall OpenLAB CDS With All of its Components
This chapter describes the uninstallation of the software.
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This chapter describes the installation of the software.
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1 Install OpenLAB CDS Workstation
Installation Workflow Overview
Installation Workflow Overview

If you plan scripted installations, see 
“Silent Installation” on page 22.

See “Install OpenLAB CDS 
Workstation” on page 7
See “Post Installation Tasks” on page 27
See “Optional Procedures” on page 55

See “Licensing” on page 35

See “Configure OpenLAB CDS 
Workstation” on page 43. 
All configuration tasks are performed in 
the administrative and management 
center of OpenLAB, the Control Panel.
For more details, refer to the Control 
Panel section in OpenLAB Help & 
Learning.

 Prepare    
 • Run System Configuration Checker    

 from the OpenLAB CDS Installer    
 to ensure that all requirements are met    

 • Check Appendix for details    
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Install OpenLAB CDS Workstation 1
Before you Begin
Before you Begin

1 Decide on a computer name. Do not use underscores. Installation is not 
possible if the computer name contains an underscore.

2 Install all required hardware, including any cables, instrument detectors, 
and communication cables. GPIB interfaces may be needed for Waters 
instruments.

3 Run the System Configuration Checker from the OpenLAB CDS Installer to 
make sure that the PC matches all requirements.

For details, see “Appendix” on page 103.

4 Update Adobe Reader 11 to the most recent version.

The OpenLAB CDS installation medium contains the initial version of 
Adobe Reader 11 (version 11.0.0). To benefit from the latest software 
improvements, especially related to the software stability, Adobe Reader 11 
must be updated to the most recent version (11.x.x).

5 Switch off the Adobe Updater.

a In Adobe Reader, click Edit > Preferences.

b On the Updater page, select Do not download or install updates automatically.

If you need to update Adobe Reader, update it manually when the 
machine is not busy.

6 If .NET 4.5.1 or higher is not installed on your system, its installation will 
automatically be triggered by the installation wizard. However, this may 
require a system reboot. To avoid the system reboot during installation, 
install .NET in advance.

7 Prepare an account with administrative privileges to run the installation.

8 If you use Trend MicroTM as an antivirus software, turn off Web Reputation 
to allow the installation of all components.

9 If you plan to upgrade from a previous version of OpenLAB CDS please 
refer to “Upgrade OpenLAB CDS” on page 91.
OpenLAB CDS Workstation 9



1 Install OpenLAB CDS Workstation
Run the OpenLAB Installer
Run the OpenLAB Installer

1 Insert the USB media, right-click the setup.exe file, and run it as 
administrator. Alternatively, copy the content of the USB media to a 
network share, and run the setup.exe file from there.

2 The OpenLAB Installer checks if the Microsoft .NET Framework 3.5 is 
available. If it is not, the installer automatically tries to install and activate 
it.

NOTE If User Account Control (UAC) is switched on, this step requires active confirmation to 
continue.

NOTE If .NET 3.5 cannot be enabled, for example, because the computer has no internet access, 
install .NET 3.5 from the Windows installation media (see Method 3 under 
https://support.microsoft.com/en-us/kb/2734782). If you do not have installation media, 
create them as described under 
http://windows.microsoft.com/en-US/windows-8/create-reset-refresh-media?woldogcb=0.
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Install OpenLAB CDS Workstation 1
Run the OpenLAB Installer
3 On the start screen, select OpenLAB CDS, and click OK.

4 Click Install/Upgrade.
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1 Install OpenLAB CDS Workstation
Run the OpenLAB Installer
5 The OpenLAB Installer checks if correct version of Microsoft .NET 
Framework is available. If it is not, you will be prompted to install it.

6 License Agreement: Read and confirm Agilent terms and conditions.
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Install OpenLAB CDS Workstation 1
Run the OpenLAB Installer
7 Installation Type: Select Standalone Workstation.
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1 Install OpenLAB CDS Workstation
Run the OpenLAB Installer
8 Installation Folder: Provide an installation folder for OpenLAB CDS. Do not 
use the root folder of any drive.
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Install OpenLAB CDS Workstation 1
Run the OpenLAB Installer
9 Select Storage Type: Choose Local File System.
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1 Install OpenLAB CDS Workstation
Run the OpenLAB Installer
10 Storage Configuration: Provide a folder for storing the project data. Do not use 
the root folder of any drive.

If you want allow access to the projects root path only from within 
OpenLAB CDS, select Secure 'Projects Root Path'.
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Install OpenLAB CDS Workstation 1
Run the OpenLAB Installer
11 Prerequisite Check: Mandatory settings in the operating system are checked1.

The report is located in C:\ProgramData\Agilent\InstallLogs\<date and time>. 
Note that ProgramData is a hidden folder.

In case of errors, see the following hints:

• Is the name of the installation folder still applicable?

• Is there enough space available on the hard disk? For details, refer to the 
OpenLAB CDS Requirements Guide (OpenLABCDSRequirements.pdf).

1 To run the site preparation tool separately before installing: Start the OpenLAB Installer, select 
the Planning page, and click System Configuration Checker.
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1 Install OpenLAB CDS Workstation
Run the OpenLAB Installer
12 Review: All components that will be installed are listed with their version 
numbers. 

• To save a properties file for a future silent installation (see “Silent 
Installation” on page 22), click Save to config File.

• To start the installation, click Install.
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Install OpenLAB CDS Workstation 1
Run the OpenLAB Installer
13 Install: After the installation has completed, click Next.
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1 Install OpenLAB CDS Workstation
Run the OpenLAB Installer
14 Configure: Configuration tools run in the background to configure the local 
file system. This takes about 10 min. When finished, click Next.
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Install OpenLAB CDS Workstation 1
Run the OpenLAB Installer
15 Finish:

• To confirm everything has been installed correctly, click Run Software 

Verification1.

• To complete the installation, select the Reboot the computer now check box, 
and click Finish.

16 In case of errors during the installation: Check the installation log files 
under C:\ProgramData\Agilent\InstallLogs\[date and time]. Note that ProgramData 
is a hidden folder.

The installation includes a set of standard instrument drivers. If you need 
other instrument driver software, install it in a separate step. See “Install or 
Upgrade Driver Software” on page 25.

1 To start the tool separately at a later point in time, select Start > Agilent Technologies > Software 
Verification Tool.
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1 Install OpenLAB CDS Workstation
Silent Installation
Silent Installation

OpenLAB CDS supports a command-line mode for installation, also referred 
to as silent installation. This mode supports installation, upgrade, repair, and 
uninstallation. You can execute silent installations either manually or as part 
of software management systems such as LANDesk or HP CM.

Export Properties File 
The OpenLAB Installer supports a feature to export the installation 
parameters into a properties file which you can then use for the silent 
installation.

1 Launch the OpenLAB Installer.

2 Follow the instructions of the wizard.

3 When you have reached the Review screen, click Save to config file.

Save the file to a suitable location. The file will automatically be saved as a 
.properties file.

You can now use the properties file for the silent installation.
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Install OpenLAB CDS Workstation 1
Silent Installation
Run Installation
Prerequisites • You have prepared a properties file for silent installation. See “Export Properties 

File” on page 22.
• .Net Framework is present on your system.

If it is not present, it will automatically be installed. You must then manually select 
Accept to agree with the license agreement.

1 Copy the content of the USB media to a centralized folder.

2 Copy the properties file to the same directory as the CDSInstaller.exe.

3 Right-click the executable of the command prompt or Power shell prompt, 
and run it as administrator.

4 Navigate to the location where you have saved the installation files.

For example: C:\CDS

5 To start the installation, call CDSInstaller.exe with the following syntax: 

CDSInstaller.exe -s -c <PropertiesFile>

For example:

CDSInstaller.exe -s -c Silent.Properties

With this command, you start the OpenLAB Installer without a user 
interface.

6 Wait about 5 minutes while the installation takes place. To check the 
process of installation, look at the log files under  %ProgramData%\Agilent\
InstallLogs.

If a required installable is missing, the OpenLAB Installer will create an 
entry in a log file, and, depending on the component type, will continue or 
roll back the installation. An error code will be returned in such scenarios.

7 After the installation has finished, reboot the PC.
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1 Install OpenLAB CDS Workstation
Silent Installation
Parameters and Return Codes

Parameters
Use the following parameters when calling CDSInstaller.exe in command-line 
mode:

• -s

Silent mode - no user interface will be shown.

• -c

Configuration file - a properties file contains all parameters. 

•  <PropertiesFile>

The properties file contains all required inputs for the installer. Replace 
<PropertiesFile> with the correct file path and file name. The file must be 
located in the same directory as the CDSInstaller.exe. 

Return Codes
After installation, uninstallation, upgrade, or repair in the command-line 
mode, the system will return a number code which is explained below.

Logging and Tracing
All exceptions, errors and information messages are logged under C:\
ProgramData\Agilent\InstallLogs\<date and time>. Note that ProgramData is a hidden 
folder.

Table 2 Return codes

Error/return code Return value

Success. You can see all of the information in 
the log file.

0

Failure. Verify against the log file to see what 
failed.

any other number
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Install OpenLAB CDS Workstation 1
Install or Upgrade Driver Software
Install or Upgrade Driver Software

The following driver software packages are automatically installed and 
configured with OpenLAB CDS. For details, see “Instrument Connections” on 
page 127.

• Agilent GC & GC/MS

• Agilent LC & LC/MS

• Agilent A/D

• Virtual Instruments

Other instrument driver software, add-on software, or upgrades to existing 
driver software, must be installed and configured manually. Instrument driver 
software and add-on software can be found on the installation media under 
Setup\Packages\Add-Ons.

The latest Agilent drivers are available in SubscribeNet. In the Product List, 
select OpenLAB Software > OpenLAB Agilent Instrument Drivers.

Install or upgrade driver software

1 Run the installer package, and follow the installation wizard.

For details on the installation or upgrade procedures, refer to the 
respective driver documentation.

2 Register driver software with OpenLAB CDS.

See “Register driver software with OpenLAB CDS” on page 26.

The OpenLAB Configuration will find all newly installed or updated instrument 
drivers and register them with the Shared Services. New instrument types will 
be available in the Control Panel.
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1 Install OpenLAB CDS Workstation
Install or Upgrade Driver Software
Register driver software with OpenLAB CDS
Register driver software with OpenLAB CDS

The following procedure must be carried out after installing drivers other 
than the ones listed above, and after upgrading any driver. With these steps 
you make the new drivers available in OpenLAB CDS.

1 In Windows, select Start > All Programs > Agilent Technologies > OpenLAB 
Configuration.

2 In the OpenLAB Configuration tool, enter one of the following strings as a 
server name:

• The IP address of the workstation, starting with 192.x.x.x

• The IP address of the localhost, 127.0.0.1

• The computer name

3 Click Connect to enable the input boxes for the user credentials.

4 Under Step 2 - Authentication, enter your user credentials.

5 Make sure the Register as Instrument Controller check box is cleared.

6 Click Register.
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This chapter describes tasks that are relevant after finishing the installation.
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2 Post Installation Tasks
Set Account to Enable Automatic Printing
Set Account to Enable Automatic Printing

OpenLAB CDS allows you to process your data already during the acquisition, 
without opening Data Analysis. During this automatic processing you can also 
generate reports and print them to printer or save them as files. Exporting the 
reports to a network share is a typical way how they are sent to an external 
system (for example, LIMS).

To access a printer, and also to access a network share, Data Analysis must be 
started from an account with the required configuration and privileges.

1 Create a domain user or local user with access to the relevant printer and 
network share.

2 On the Workstation, add the new user to the local Administrators group.

3 Log in as the new user, and configure the relevant printer as this user's 
default printer.

4 Change the Agilent OpenLAB Instrument Service to run under this user.

a In the Windows command line, run services.msc as a user with 
administrative rights.

b In the Services window, right-click the Agilent OpenLAB Instrument Service, 
and select Properties.

c On the Log On tab, select This account, and enter the credentials of the new 
user.

5 Reboot the PC.
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Post Installation Tasks 2
Configure the Antivirus Program
Configure the Antivirus Program

1 Be sure to open the firewall ports listed in the Firewall Settings in the 
OpenLAB CDS Requirements guide.

2 For best performance, consider the following folder exclusions. These 
folders should only be scanned while the instruments are idle, and no data 
acquisition or data analysis takes place.

• [C:\]CDSProjects

• [C:\]Program Files (x86)\Agilent Technologies

• [C:\]ProgramData\Agilent

• [C:\]ProgramData\Agilent IPB Files

• [C:\]ProgramData\Agilent Technologies

• [C:\]ProgramData\ChromatographySystem

• [C:\]ProgramData\Firebird

• [C:\]ProgramData\IsolatedStorage

Refer to your specific antivirus software documentation on how to 
configure folder exclusions.
OpenLAB CDS Workstation 29



2 Post Installation Tasks
Configure the Antivirus Program
Settings for Trend MicroTM antivirus software 

OpenLAB CDS can be used with other antivirus programs as well. If you 

use Trend MicroTM, the following settings are recommended to optimize 
system performance.

1 Web Reputation: Turn off to maximize performance.

The risk of turning off Web Reputation is that web traffic through browsing 
from the machine will not be checked.

Ensure that there is another URL/web scanner on the gateway level to 
protect the endpoint, or ensure that the endpoints have limited access to 
Internet. These production machines should not have access to Internet 
websites where most of the infections are coming from.

2 Real time scan: Add exclusions, and modify scan direction from 
Created/Modified/Retrieved to Created/Modified.

Exclusions ensure that the working directory of Agilent Technologies will 
not be scanned, thus improving performance.

The risk is that only files that are created and changed on this machine are 
scanned. Files that are just accessed will be bypassed. Dormant Files that 
got infected without being noticed at the time they were created or written 
to the machine will not be scanned.

Increase scheduled scan to daily to ensure all files on the machine are being 
checked for infections that are dormant or not moving.

3 Behavior Monitoring: Add below list of programs to Approved programs.

C:\Program Files (x86)\Agilent Technologies\...

• OpenLAB Acquisition\Agilent.OpenLAB.Acquisition.AcqInstrumentService.exe

• OpenLAB Acquisition\Agilent.OpenLAB.AcquisitionClient.exe 

• OpenLAB Data Analysis\Bin\
Agilent.Chromatography.DataAnalysis.Processing.ProcessingServer.exe

• OpenLAB Data Analysis\Bin\
Agilent.Chromatography.DataAnalysis.UI.CustomCalculationDesigner.exe

• OpenLAB Data Analysis\Bin\Agilent.OpenLab.DataAnalysis.exe

• OpenLAB Data Analysis\Bin\Reporting\
Agilent.OpenLab.Reporting.RdlDescriptor.exe

• OpenLAB Data Analysis\Bin\Reporting\
Agilent.OpenLab.Reporting.RdlDescriptorContextMenu.exe
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Post Installation Tasks 2
Configure the Antivirus Program
• OpenLAB Data Analysis\Bin\Reporting\
IntelligentReporting.RenderServiceHost.exe

• OpenLAB Data Analysis\Bin\Reporting\TemplateDocumentation.exe

• OpenLAB Services\Automation\AutomationServerHost.exe

• OpenLAB Services\Diagnostics\DiagnosticsToolsServiceHost.exe

• OpenLAB Services\Licensing\Flexera\lmadmin.exe

• OpenLAB Services\Licensing\Licensing.Service.Host.exe

• OpenLAB Services\Server\SharedServicesHost.exe

• OpenLAB Services\UI\Agilent.OpenLab.ControlPanel.exe

The risk is that if any of the excluded files get infected, it will not be 
detected. For example, trigger a schedule on a daily basis to cover these 
files.

4 Realtime monitoring: Add below folder to the exclusion list of Realtime 
Monitoring setting:

C:\Program Files (x86)\Agilent Technologies\
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2 Post Installation Tasks
Configure Internet Explorer for OpenLAB Help and Learning
Configure Internet Explorer for OpenLAB Help and Learning

If you use Google Chrome, no further settings are required.

If you use Internet Explorer as your default browser: Make the following 
settings to ensure that OpenLAB Help and Learning is opened without 
showing a confirmation prompt.

1 In Internet Explorer, click Tools > Internet Options.

2 Select the Advanced tab.

3 Under Security, select Allow active content to run in files on My Computer.

4 Confirm your settings.

5 Reboot the computer to make the settings effective.

Local Windows Account for Secure Projects Root Folder

If you installed OpenLAB CDS using the Secure 'Projects Root Path' option, your 
projects folder (by default, C:\CDSProjects) and anything within this folder is 
locked. Only the local Windows user AgtSfsUser and the local Windows group 
AgtSfsGroup are able to browse this folders. They have been created during 
installation. 

To ensure that the system is working properly:

• Do not delete this group and account, and

• Do not disable Windows logins for local accounts.

CAUTION The application may become unusable
If you change file access privileges, Windows 10 removes the default ownership. As a 
result, OpenLAB CDS will be unable to access your data.

➔ Request Agilent's support if you need to change privileges on file system level.
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Post Installation Tasks 2
Disable Windows 10 Updates
Disable Windows 10 Updates

Your company's security policy may require that Windows updates not be 
automatically applied. Updates may need to be tested first, and then be 
distributed internally.

With Windows 10, automatic updates cannot be turned off in the Windows 
settings as in earlier Windows versions. Instead, you must disable the 
Windows Update service. As this service is required during installation, you 
can only disable it after finishing the installation.

1 In the Start menu, search for services.msc and press Enter to open the Services 
window.

2 Double-click the Windows Update service.

3 Set the startup type to Disabled.

NOTE The computer will not be automatically updated anymore. Make sure you keep the 
computer up to date by other means.
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2 Post Installation Tasks
Disable Windows 10 Updates
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This chapter provides basic information on licensing. It describes how you 
generate a license file with SubscribeNet and install the license in the Control 
Panel.
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3 Licensing
About OpenLAB CDS Licensing
About OpenLAB CDS Licensing

Software subscriptions and Software Maintenance Agreement 
(SMA)

Bundled into OpenLAB CDS is a one-year software subscription which 
provides access via SubscribeNet to new software updates, product upgrades, 
familiarization and media.

As a best practice, we recommend customers renew subscriptions annually so 
as to maintain their licenses and have full access to the newest updates, 
upgrades, media and familiarization. To manage software entitlements, order 
media or download software, log in to SubscribeNet by pasting this link in 
your browser: http://agilent.subscribenet.com/

Software subscriptions do not include installation services. Installation or 
upgrade services must be purchased by contacting your sales representative in 
your region.
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About OpenLAB CDS Licensing
License Types
The license file is a collection of Product, Instruments and Add-on licenses (or 
activation keys), and is installed to your OpenLAB CDS System. Both the 
OpenLAB Workstation PC, or the OpenLAB Server in a Client/Server system 
will act as the license server.

The licenses or activation keys in the license file can either be Shared or 
Counted:

• Shared licenses — system computers and other components can have 
shared, or add-on, licenses — because they share a core license.

• Counted licenses — these licenses are part of the OpenLAB CDS floating 
licensing strategy. They are not permanently assigned to any one 
component. Instead they are automatically assigned to components, such as 
AICs and instruments, while the components are starting up. The licenses 
are automatically returned when the component is closed. The license 
management program controls license issuance and retrieval.

In this case, the only requirement is that a component is licensed while 
running. You only need enough licenses for all components running 
concurrently, rather than for each installed component.

A startup license for the system allows you to run OpenLAB CDS for 60 days 
after the installation. In order to run the data system software after the 60-day 
period, you must install your license file.

License File
A license file will contain your software license. This file is installed on the 
workstation. The license file is bound to this computer, and cannot be moved 
to another workstation without regenerating the license in SubscribeNet.

Information in the license file defines the number of instruments and other 
options that may be used concurrently with your system.

The most efficient way to manage and maintain your licensing is through the 
Internet.
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3 Licensing
Get a License
Get a License

Obtain a License with SubscribeNet
Use the following procedure to generate and download your license. In case 
you do not have internet access, skip to the section “Other Ways to Obtain a 
License” on page 40.

If you are a new user who has not registered with SubscribeNet, continue with 
the section New Users.

If you have registered with SubscribeNet, skip to the section Users registered 
with SubscribeNet.

Prerequisites To generate, download, and install a final license for your product, you will need:
• The authorization code label provided in the lavender envelope containing your 

Software Entitlement Certificate.
If you have not received a lavender envelope for your product, contact your vendor or 
internal support.

• The URL for SubscribeNet from the Software Entitlement Certificate.
• The host name of the computer where the Control Panel is running.
• The MAC address.

To retrieve your MAC address from a computer where OpenLAB CDS is already 
installed, open the Control Panel and browse to the Administration > Licenses section. 
Use the Copy MAC Address or Save MAC Address function to obtain the MAC address 
for license generation.
During this process you will have to enter the MAC address of your license server. For 
workstations, this is the local computer. For client/server systems, this is the server.

NOTE If any changes are made to the computer name or domain reference after the license is 
installed, remove the license. A new license will need to be created in SubscribeNet, 
downloaded, and installed.

NOTE If the network adapter that provides the MAC address used during license creation is 
removed from the machine, your license will no longer be valid. A new license will need to 
be generated with a currently available MAC on the license server.
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New Users

1 From a computer with Internet access, enter the URL provided in the 
Software Entitlement Certificate in an Internet browser 
(https://agilent.subscribenet.com/control/agil/AgilRegisterToAccount).

2 On the registration page, enter the authorization code from the label and 
complete the profile information (required fields are marked with an 
asterisk *).

The email address you enter will become your login ID.

3 Click Submit. The system will generate and display an account name for you. 

SubscribeNet will send a welcome email with your login ID and password.

4 Log in to SubscribeNet using your login ID and password.

Once you log in, you can use the online user manual link for help with any 
questions you have.

5 Select Generate or View licenses from the left navigation bar.

6 Follow the prompts to generate your new license.

You will be prompted for the HOST NAME of the computer. The host name 
you enter must match with the network name of the computer where the 
Control Panel is running. Do not include any DNS suffix (domain.com) 
references in the entered machine name.

7 When the system generated the license, view its details, then click Download 
License File. Save the license file to your computer and to a backup location 
(such as a portable storage device).

Use your login ID and password when you revisit the Agilent SubscribeNet 
site to regenerate a license file, add new authorization codes, or further 
configure the license for your system.

Users registered with SubscribeNet

1 Login to SubscribeNet with your e-mail address and password.

2 Select the SubscribeNet account associated with this authorization code, if 
you have more than one account.

3 From the SubscribeNet navigation pane, select Register Authorization Code.

This will allow you to enter your new authorization code and make available 
the new license entitlements

4 Follow steps 7 through 9 in the previous procedure, New Users, to generate 
or view your new licenses.
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Other Ways to Obtain a License
If you are unable to generate a license, contact your nearest Agilent technical 
support office. A representative will tell you how to submit an OpenLAB CDS 
License Generation Form in your location.

Offline Licensing
If an internet connection is not available in your laboratory:

You or your local on-site service engineer will collect the necessary 
information from you to allow Agilent to create a license account on your 
behalf. For phone support in your region, call the sales and service number for 
your region. See the Appendix for a list of numbers for various countries.

Required Customer Information for Agilent License Support:

The following information must be provided to Agilent in order to enable us to 
create a licensing account on your behalf.

1 Collect Account Information:

Your account name will be your company name and Lab name separated by 
a comma. Employee information provided here will be used to define the 
first administrator of your account for future access to the system as 
required. Please prepare the following pieces of information prior to 
contacting your local Agilent sales and service center in order to expedite 
service:

• Company Name

• Lab/Department Name

• First Name

• Last Name

• E-mail address

• Job Title

• Phone #

• Address, City, State/Province, Postal Code, Country

2 Collect Authorization Code(s):

The authorization code is an alpha-numeric code provided on a label which 
is enclosed in a lavender envelope. If you have received more than one code 
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you must provide all codes to ensure that all ordered licenses are granted to 
your account.

3 Receiving your license:

Once the above information is provided Agilent will then work on your 
behalf to generate a license file through SubscribeNet. The license file will 
either be sent to your shipping address (on a CD), or your local FSE will 
deliver it in person (usually on USB media). Once your license is received 
follow the below section on “Install your License” to finish installing your 
license on your CDS system(s).
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Install Your License

The license must be added to your system using the Control Panel.

1 Start the Control Panel shortcut on the desktop or go to Start > All Programs > 
Agilent Technologies > OpenLAB Shared Services > Control Panel.

2 Navigate to Administration > Licenses.

3 In the ribbon, click Add License .

4 Choose to install the license by:

• Using the license file option to browse to and open the license file (.lic) 
saved from the license generation process in SubscribeNet.

• Selecting the License Text option and copying the license text from a text 
file received into the provided field.

5 Click OK.

The Administration interface in the Control Panel will now display the status 
of installed licenses.
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This chapter describes the initial configuration steps after installing the 
software. For more details, refer to the Control Panel section in OpenLAB Help 
& Learning.

CAUTION This chapter is not applicable if you are migrating from OpenLAB CDS ChemStation 
Edition.

➔ If you are upgrading from OpenLAB CDS ChemStation Edition be sure to refer to 
the "OpenLAB Migration Tool user guide" prior to configuring OpenLAB CDS.
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Configure Authentication

OpenLAB CDS supports the following authentication providers:

• None (default setting after installation)

In this mode, no login screen is shown when you access the Control Panel. 
The user is automatically logged in to the application with security 
disabled. All log entries record the user as "Anonymous". With the 
authentication provider None, the Security Policy and User Management 
nodes are unavailable in the Control Panel.

• Internal

In this mode, the user's credentials are stored in the OpenLAB CDS system. 
You are asked to create an administrator account for OpenLAB CDS before 
setting up other users. This is the only mode in which you can create new 
users within the system; in all other modes you can only map to users that 
exist in a different system.

• Windows Domain

You import existing Windows users into OpenLAB CDS system. The 
authentication is done either by Windows Active Directory domain or NT 
4.0 Domain within the Enterprise. OpenLAB CDS only uses the identity and 
password of the mapped users; roles and privileges for OpenLAB CDS are 
still configured in the Control Panel.

1 Launch the Control Panel.

2 Navigate to Administration.

3 In the navigation pane, select System Configuration.

4 In the ribbon, click Edit System Settings .

NOTE With the authentication provider None, any activity logs will display a generic System 
operator with no additional identification. This is not recommended for compliant setups.
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5 Select the required authentication provider from the drop-down list, then 
click Next.

6 Provide user credentials:

a For Windows Domain: Select the check box to use a domain user, and 
provide user credentials with the rights to obtain user and group 
information. Then click Select Account to open the Search Users dialog and 
select an administrator account.

b For Internal: Click Create Account to create a new administrator account 
for OpenLAB CDS.

7 Confirm your settings. When complete, the Control Panel will restart.

NOTE Do not change the storage type.
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Configure Security Policy

If you need to comply with specific standards, adjust the security policy as 
required.

With the authentication provider Internal, you can set all parameters in the 
Control Panel. With an external authentication provider (Windows Domain), 
you can only set the inactivity time in the Control Panel; all other parameters 
are defined by the external system.

1 Launch the Control Panel and navigate to Administration.

2 In the navigation pane, select Security Policy.

3 In the ribbon, click Edit Security Policy.

Configure users, roles, and privileges

With internal authentication, you create the required users in the Control 
Panel. With Windows domain as an external authentication system, you 
import the Windows domain users.

To define what users are allowed to view or do, OpenLAB CDS offers 
predefined roles and allows you to define your own specific roles. Roles are 
equipped with numerous specific privileges.

Each user can be member of multiple groups. You must assign one or more 
specific roles to each group. You can also assign roles to single users; however, 
for the sake of clarity, it is strongly recommended to assign roles only on the 
group level. Every member of a group automatically has all roles of this group.

1 Launch the Control Panel and navigate to Administration.

2 In the navigation pane, select Users, Groups, or Roles.

3 Create new items, or edit the existing ones.
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Create or import users
Use the Control Panel to manage the roles and privileges. You can create 
custom roles, or assign one or more of the predefined roles to give users 
varying degrees access.

Add users (Internal Authentication only)

1 From the navigation pane, click Administration > Users.

2 In the ribbon, click Create User.

3 In the Create User dialog, provide the relevant parameters:

• Enter the name and password for the new user.

• By default, the new user will need to change the password at next logon. 
If this is not required, clear the User must change password at next logon 
check box.

• In the Role Membership tab, assign the user to an appropriate role. You 
can use the default roles, or prepare your own roles in the Control Panel 
under Administration > Roles.

4 Click OK.

Import users (Windows Domain Authentication only)

To add users to your system, you must have privileges to obtain user and 
group information from the domain.

1 From the navigation pane, click Administration > Users.

2 In the ribbon, click Import.

3 In the Search Users dialog box, enter search string for the Windows domain 
username.

4 From the Search Results list, select the user you want to import, and click 
Add. The user is added to the Selected Users list.

5 Repeat steps 2 through 4 until you have added all the user names that you 
want to import to the Selected Users list, then click OK.
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Groups
If you use an external authentication provider, you can either import the 
names of groups that exist in the external system, or create new internal 
groups. There is no limit on the number of groups that can be mapped or 
created.

Assign users to groups either in the external system or in the Control Panel. If 
you need additional user assignments that are relevant only for OpenLAB 
CDS, create them in the Control Panel. Otherwise it is sufficient to only import 
the groups and assign the required roles to the groups.

If you delete or unmap a group, the users who were members in this group 
remain unchanged.

Roles and Privileges
Roles are used to assign privileges to a user or a user group globally or for a 
specific instrument, project, project group or location. The system contains a 
list of predefined roles which are installed as part of the system installation 
(for example, Instrument Administrator, Instrument User, or Everything). Each role 
has certain privileges assigned.

Privileges are grouped according to the three main role types (Project role, 
Instrument role, and Administrative role). When you assign privileges to a 
role, you first select the required role type and then select the privileges 
related to this role type. Each role can only have privileges of one specific role 
type; the only exception is the predefined role Everything, which has all 
privileges of all role types. Users or groups may require multiple roles to 
perform system functions. For example, a user with the role Chemist may 
need another role such as Instrument User with the privilege to run an 
instrument.

You can create a tree of different locations in the Control Panel, and add 
instruments to the relevant locations. For each instrument or instrument 
group, you can assign different Instrument roles (see also “Specific Roles for 
Individual Instruments or Projects” on page 50). For example, a user can have 
the role Instrument Administrator for one instrument, and Instrument User for 
another instrument.
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You can also create a tree of different projects or project groups in the Control 
Panel, and assign different Project roles for different projects (see also 
“Specific Roles for Individual Instruments or Projects” on page 50). For 
example, a user can have the role Project Administrator in one project, so that he 
can manage the settings in the Control Panel. In a second project, he may have 
a role that allows him to edit the content of a project, but not to change the 
project settings. 

For more information on privileges, see the Appendix.

Add users or groups to a role
1 From the navigation pane, click Administration > Roles.

2 In the Roles window, select the role you want to assign to users or groups.

3 In the ribbon, click Edit Role.

4 In the Edit Role dialog box, click the Members tab.

5 Click Add user or group.

6 In the Search Users and Groups dialog box, enter the name of a user or group, 
and click Search to view a list of all users and groups that meet the search 
criteria.

7 Under Search Results, select a user or group, and click Add.

8 Click OK.

Table 3 Description of role types

Role Type Description

Administrative privileges These privileges are globally assigned to a user or group and cannot 
be changed on the instrument/location level. They are the typical 
administration privileges such as Backup and restore, Manage 
security, Manage printers etc. 

Instrument privileges These privileges can be assigned globally or on the 
instrument/location level. Privileges for instruments are, for example, 
View instrument or location and Run instrument.
Users need the View instrument or location privilege on the global 
level to see the locations and instruments tree in the Control Panel.

Project privileges Privileges for accessing or modifying different levels of data. You can 
assign these privileges globally or on project or project group level.
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Specific Roles for Individual Instruments or Projects
By default, the roles of users or groups are globally set for all locations, 
instruments, project groups, or projects. The role settings are inherited from 
the root node Instruments or Projects respectively. In order to assign a different 
role to a user or group for one specific node, you can deselect the Inherit 
privileges from parent check box in the Edit Privileges dialog for the required 
node. Afterwards, you can assign a different role that will be valid only for the 
specific node. 

You can assign Instrument roles to individual locations or instruments. 

If you use projects, you can assign Project roles to individual project groups or 
projects.

Administrative roles are always set globally.
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Configure the Storage Location

All project data is stored on the local file system. Each project has its own 
project folder, but all project folders are located in the Projects Root Path. The 
following procedure explains how to change Projects Root Path.

Prerequisites To be able to change the Projects Root Path, the directory must be empty. You did not yet 
create any projects.

1 Launch the Control Panel.

2 Navigate to Administration.

3 In the navigation pane, select System Configuration.

4 In the ribbon, click Edit System Settings .

5 Select the storage location File System from the drop-down list, then click 
Next.

6 Provide the new Projects Root Path.

7 Confirm your settings. When complete, the Control Panel will restart.

NOTE If you already created projects, move the data away temporarily, then delete the the 
project. After you have set the correct path, create the projects again and move the data 
back.
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Enable File System Security

With File System Security, you prevent users from modifying OpenLAB files 
outside OpenLAB CDS. File System Security may have been enabled already 
during installation, but you can enable it at any time. File System Security is 
optional.

1 Launch the Control Panel.

2 Navigate to Administration.

3 In the navigation pane, select System Configuration.

4 In the ribbon, click Edit System Settings .

5 Select the storage location File System from the drop-down list, then click 
Next.

6 Select the Secure project folder check box, then click Next.

7 Confirm your settings. 

Configure Initial Project

1 Launch the Control Panel and navigate to Projects.

2 Create and configure a project:

On the CDS Settings tab:

• Enter the locations for Methods, Sequences, Results, Sequence Templates 
and Report Templates.

• Consider the required audit trail settings for this project.

For more details, refer to the Control Panel section in OpenLAB Help & 
Learning.
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Configure Initial Instrument

1 Launch the Control Panel and navigate to Instruments.

2 Click Create in the ribbon to create a new instrument.

3 Select the new instrument, and click Configure Instrument in the ribbon.

4 It is recommended that you use Auto Configuration to configure your 
instruments: Select a module, click Auto Configuration, and provide the 
instrument's IP address or hostname.

For more details, refer to the Control Panel section in OpenLAB Help & 
Learning.

Other settings in the Control Panel

Consider also other settings in the Control Panel, such as:

• changing the instrument status reporting frequency, or

• changing audit trail settings for a project,

• editing signature levels for a project (only accessible from an OpenLAB CDS 
Workstation or Client).

For more details, refer to the Control Panel section in OpenLAB Help & 
Learning.
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Other settings in the Control Panel
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This chapter describes the installation or upgrade of additional instrument 
driver software. It also contains information on the installation of OpenLAB 
Help and Learning only, and on performance improvement on offline machines. 
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Install OpenLAB Help and Learning Only

Use this option to install OpenLAB Help and Learning content without 
installing OpenLAB CDS applications.

Do not use this option on a machine where OpenLAB CDS is, or will be, 
installed.

1 Insert the USB media, right-click the setup.exe file, and run it as 
administrator.

2 On the start screen, select OpenLAB CDS, and click OK.

3 In the OpenLAB CDS Installer, click Documentation.

4 Click Install OpenLAB Help and Learning Only.

5 Select your language, and click Next.

6 On the welcome screen, click Next.

7 Confirm Agilent terms and conditions, and click Next.

8 Review the installation directory. If desired, click Change... to specify a 
different directory.

9 Click Install.

10 When the installation is complete, click Finish.

11 If you plan to use Internet Explorer to view the content, set the Internet 
Options as described under “Configure Internet Explorer for OpenLAB 
Help and Learning” on page 32 .

Without these settings, you will need to click Allow blocked content when 
opening the help.

No settings are required for Google Chrome.

You can uninstall or repair OpenLAB Help and Learning from the same link in 
the installer (see “Uninstall OpenLAB Help and Learning Only” on page 97).
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Improve Performance on Offline Machines

Computers running OpenLAB CDS may exhibit slow performance when they 
are not connected to the Internet.

The windows operating system has routines built into its operation that 
causes it to continuously search for an online connection in order to update to 
all the latest Windows security certificates when using secure software.

Use the following system settings on all workstations to remedy this problem.

1 Open Internet Explorer and select Tools > Internet Options. In the Advanced 
tab, clear the following check boxes:

• Security > Check for publisher's certificate revocation

• Security > Check for server certificate revocation

2 Change the following registry keys:

• [HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\
SystemCertificates\AuthRoot] 

"DisableRootAutoUpdate"=dword:00000001

• [HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Policies\
Microsoft\SystemCertificates\AuthRoot]

"DisableRootAutoUpdate"=dword:00000001

3 Document that you turned off the Root Certificates, as this can prevent 
users from installing other applications.
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This chapter contains an overview of the software architecture and 
customization options.
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Software Architecture

OpenLAB CDS is a data system solution for analytical workflows that controls 
a wide variety of instruments including the industry-leading GC and 
GC/MS-SQ instruments, along with best-in-class LC and LC/MS-SQ. By 
combining chromatography and single-quad mass spectrometry into a single 
scalable solution with centralized system administration, you can streamline 
your laboratory workflows and maximize productivity. A tailored and 
simplified user interface with a new state-of-the-art user experience, along 
with e-learning tools, to help you to get up to speed and productive as fast as 
possible.

The Agilent OpenLAB CDS software is provided on read-only USB media that 
contain all required installables and documents. This includes:

• Acquisition

• Data Analysis and Reporting

• Shared Services

• Content Management

• Custom Calculation Editor

• Help and Learning Platform

• User documentation

• Instrument driver software for Agilent LC, GC, LC/MS, GC/MS, or A/D

• Instrument driver software for virtual instruments (Data Player)

• Agilent Parts Finder

• Third party tools
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Workstation: All components on a single PC; results are stored in the local file 
system; the system supports up to four instrument connections. 

Figure 1 OpenLAB CDS Workstation
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Software Architecture
Workstation Plus (with Content Management): All components on a single 
PC; results are stored in a database provided by the Content Management 
component; Users have no access to the data via the local file system; supports 
up to four instrument connections.

Figure 2 Components on a Workstation Plus

Local File System
All project data such as methods, raw data, results, templates, or reports are 
stored in the local file system. Each project has its own folder. All project 
folders are located in one specific Projects Root Folder.

By default, the content of the Projects Root Folder is not protected against 
modification or deletion from local file browsers. To ensure data integrity, 
select Secure project folder during installation, or select Secure project folder in 
the system settings of a ready installed Workstation.

When the project folder is secured, normal windows file operations are 
restricted to only members of the AgtSfsGroup user group.
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Customization

OpenLAB CDS can be customized to support various workflows and 
applications. Customizing capabilities are available via different approaches.

For more information on how to use custom calculations and report 
templates, refer to OpenLAB Help & Learning.

Customization via custom calculations
Data Analysis can be enriched by calculating additional values. The 
calculations are done with the Custom Calculator Designer and referenced by 
or embedded in a processing method.

These calculations can be quite complex. The calculation results are directly 
visible in Data Analysis, no report generation is needed.

Custom calculations are processed on result set level. They are only computed 
if all injections of the result set are processed together.

Customization via report templates
In a report template you can call calculation results from a method-specific 
custom calculation, or define additional, template-specific calculation 
expressions. The template-specific values are only visible in the report 
preview or the final report.

Reports are generated on either injection level, result set level, or across 
multiple result sets. Reports can be used for automated result evaluation on 
all the mentioned levels.

Example report templates for typical petrochemical or pharmaceutical 
applications are provided with the application and can be imported in Data 
Analysis (see Import default templates in OpenLAB Help & Learning).
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Customize application to start external programs
The customization capabilities allow to add ribbon groups and icons in the 
Data Selection and Data Processing views of OpenLAB Data Analysis.

It is possible to start an external program via an icon and to hand over the 
project data path and the path of the current injection as parameters to the 
program.

The customization is based on a file CustomToolsConfiguration.xml at C:\
ProgramData\AgilentTechnologies\OpenLAB DataAnalysis\ that needs to be created 
by the user. An example CustomToolsConfiguration.xml file is included on the 
media at Setup > Tools > Support > UCL > Customization folder.

For more information, refer to OpenLAB Help & Learning.
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This chapter contains information on the Control Panel and Shared Services 
Maintenance. In addition, it describes various maintenance procedures.
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Control Panel

Using the Control Panel, you can access Shared Services control features such 
as security policy, central configuration, or lab status at a glance.

Instrument Management / Lab Status at a Glance
The Instruments view in the Control Panel offers an overview of all instruments 
in the network or on the workstation. You can see the following information 
for all instruments, summarized on one page:

• Status of the instrument with related color code

• Instrument name

• Instrument location

• Instrument type

• Last change of configuration

Depending on the configuration, this information may be accessed from a 
single workstation PC or from multiple clients in a network.

You can create a tree of different locations in the Control Panel, and add 
instruments to these locations. Using locations, you can organize your 
instruments for example by department, by laboratory, or by lab bench. For 
each instrument, you can provide basic information such as the name, 
description, and instrument type.
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Depending on your privileges in OpenLAB CDS, you can perform several 
operations on the instruments:

• View instrument information (instrument status, instrument details, 
activity log)

• View the locations and instruments tree

• Edit the instrument information

• Configure the instrument

The instrument configuration is stored in the Shared Services database. 
You access the configuration tool from the Control Panel.

• Launch the instrument

On a Workstation, you can only launch instruments that are configured on 
this PC.

With a Client/Server system, you can launch instruments remotely from any 
OpenLAB CDS client in the network.

Your privileges can differ for the different locations and instruments (see 
“Specific Roles for Individual Instruments or Projects” on page 50). 

License Management
This service includes the administration of all licenses that are required for 
your system.

Before adding a license file, you must first purchase the license and generate 
the license file using SubscribeNet. For more information on generating new 
license files, see “Obtain a License with SubscribeNet” on page 38.

License Management in the Control Panel provides the following functions:

• You can add license files to the license server.

• You can navigate to the license monitor and view the properties of all 
licenses installed on a given license server.

• You can remove license files from the license server. This may be useful if an 
invalid license file has been added.

• You can view or change the license server.

• You can view, copy, or save the MAC Address of the license server.

• You can navigate to the Agilent Electronic Software and License Delivery 
web page to obtain a license.
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The following properties are shown for installed licenses:

• Feature: This indicates the type of license used.

• Version: If a license is versioned, you can see the version number. For 
licenses that are not versioned, the version is always shown as 1.0.

• In Use (Available): This indicates the number of licenses that are currently in 
use and, in brackets, the total number of licenses. With the OpenLAB CDS 
licensing strategy, a license is only in use as long as a software instance is 
running (see “License Types” on page 37).

• Expiration: If the license is only valid for a certain period of time, the 
expiration date is displayed.

In the Alerts pane, you are informed if the number of available licenses has 
gone down to zero for a specific feature, or if you have started a software 
instance which requires a license that is unavailable.

For more information on adding license files and viewing the license 
properties, refer to the Control Panel section in OpenLAB Help & Learning.

System Activity Log
The System Activity Log allows you to centrally access all system activities. It 
contains information on the various events associated with Shared Services or 
with specific instruments. You can filter the list in order to view only events of 
a specific type, in a specific time range, created by a specific user, or 
containing a specific description.

The following types of events are recorded:

• System

• Instrument Management

• Instrument

• Project Management

• Instrument Controller

• User

• Group

• Security

• Printer

• License
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The messages can come from other components, such as the user management, 
or from an instrument module. Instrument messages include error messages, 
system messages, or event messages. The System Activity Log records these 
events irrespective of whether you have been alerted to them or not. To get 
more information on an event, expand the line of interest in the activity 
logbook viewer.

Diagnostics
The Diagnostics view allows you to access several reports and tools for 
diagnostic purposes:

• Ping the server.

• Create a report, either for the local system or for the server, with 
information on the operation system, processors, disk drives, processes, 
network, and connections.

• Centrally access and download all the log files, trace files, etc. that are 
created by the registered modules.

Administrative Reports
In the Administrative Reports view, you can additionally create and export 
various XML or PDF reports related to the system configuration:

Instrument Controllers Report
Detailed information of all Instrument Controllers. When this report is 
generated on a Workstation, the information presented relates to the local 
system. When this report is generated on a client-server system, all Instrument 
Controllers are included.

Instruments Report
Provides detailed information about configuration and access privileges for all 
instruments on the system. On client-server systems, this report includes all 
instruments on all Instrument Controllers.
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Projects Report
Provides detailed information about configuration and access privileges for all 
projects on the system.

Roles and Privileges Report
Describes all roles defined on the system, including details of all privileges 
included in each role.

System Report
This report provides a consolidated view of the system, which includes all 
information about instrument controllers, instruments, projects, roles, users, 
and groups.

User's and Group's Role Assignment Report
This report provides an overview of all users and groups with their assigned 
roles.

Authentication Provider
The authentication provider is described under Configure an OpenLAB CDS 
File System Workstation. For details, see “Configure Authentication” on 
page 44.

Security Policy
The security policy is described under Configure OpenLAB CDS. For details, 
see “Configure Security Policy” on page 46.

User Management
The user management is described under Configure OpenLAB CDS. For 
details, see “Configure users, roles, and privileges” on page 46.
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Shared Services Maintenance

The Shared Services Maintenance program is automatically installed with your 
OpenLAB software to help administrators manage the system.

To open the utility, select Start > All Apps > Agilent Technologies > OpenLAB Shared 

Services > Shared Services Maintenance1. A user must have Windows 
administrator rights to access this utility.

Windows Domain
tab

In this utility, the Windows Domain tab is relevant if you use windows domain 
authentication to identify your OpenLAB users.

OpenLAB CDS must be given access to the server where these credentials are 
stored. In the Windows Domain tab, you specify or change the credentials that 
OpenLAB CDS will use to access your windows domain server.

For client/server systems: This feature can only access credentials that are 
stored on the computer where you launched the Shared Services Maintenance 
program. To specify or change the Domain, User name, or Password for the 
windows account that will be used to access your windows domain server, use 
the Shared Services Maintenance program that is installed on the server.

Server Settings
tab

The Server Settings tab can be used to manage different server connections. In a 
workstation configuration, there is typically only the connection to the local 
machine.

Activity Log
Export tab

Activity log databases can become large over time and affect performance of 
activity log related operations. Use the Export and Purge functions on the 
Activity Log Export tab to export the activity log entries to an XML file and purge 
them from the Activity Log database.

Backup and
Restore tab

The Shared Services database contains information that is accessed by the 
Control Panel (such as users, roles, permissions, projects, instruments etc.). In 
order to simplify backup and restore tasks for the Shared Services database, 
the Backup and Restore tab provides a simple interface for performing these 
tasks.

1 In Windows 7 or 8.1: Start > All Programs > Agilent Technologies > OpenLAB Shared Services > 
Shared Services Maintenance
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To perform a backup:

1 Specify the backup directory and retention time.

The retention time is used to delete any files older than specified.

2 Click Backup.

The backup is placed in the specified backup directory. Backups older than 
the retention time are deleted.

To restore to the selected backup in the list:

1 Verify that all connections to the system are shut down before performing a 
restore.

2 Select the backup that you want to restore, then click Backup.

NOTE The tool automatically generates filenames for the backup files. Never change these 
filenames, as the tool relies on a specific naming convention.
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Introduction

Disaster Recovery Planning
Prepare a recovery plan for the unlikely case of OpenLAB CDS becoming 
inoperable due to a hardware or software failure. This plan must include 
information and procedures for completely restoring the operating system, the 
software, and data. Make sure that the disaster recovery plan has been tested 
and confirmed to be working.

The Disaster Recovery Plan must include the following:

• Hardware information: CPU, Memory, and Hard disk configuration 
information.

• Computer identity: Name, IP, domain, URI, etc.

• Computer administrator information: username and passwords for 
logging in to the server

• Software information: OS version, Patch level.

• Installation parameters:

• Installation folder

• Project folder

• Installation log files

• Shared Services language

• Installed licenses

• Registered applications

• 3rd party software information: applications and their revisions and install 
paths.

• Backup procedures (see “Software backup procedure” on page 74, “Data 
Backup Procedure” on page 81)

• Backup media location and organization details.

• Restore procedures (see “Software Restore Procedure” on page 84, “Data 
Recovery Procedure” on page 85)
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Backup and Restore Procedure Overview
The backup procedure for an OpenLAB CDS Workstation with local file system 
includes all software and data. It describes how to create an image of the 
current system on a portable USB hard drive and a Windows system repair 
disc. The USB drive and repair disc are used together to restore your system to 
the original state, if needed. 

It is mandatory that every workstation is backed up regularly. Periodic full 
backups and differential backups between the full backups must be created by 
administrators. These backups are the only way to restore a system in the 
event of a hardware or software failure. It is also mandatory that a disaster 
recovery plan and restore procedures are tested to confirm that the backups 
are sufficient to restore your system.

The data backup procedure does not cover other products or databases, such 
as the GC Column Database. Create a new system image after changing other 
products or databases.

This procedure requires that the user has administrative rights on the 
workstation.

Software backup procedure
Before the backup, make sure that the Run Queue on all active instruments is 
in idle state (no active run items in the queue) and all Acquisition client 
application are closed. Use Close Connection in the Control Panel to close any 
acquisitions that may still be running.

Stop Windows Services
Open Windows Services and Stop the following services in the order listed 
below. See Microsoft Management Console help for more information on 
stopping these services.

1 Agilent OpenLAB Shared Services

2 Agilent OpenLAB Instrument Service
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Figure 3 Stop Services

Create an Image of the Current System
Create a new system image after any change in your instrument 
configuration.

1 Connect a portable USB drive to a (blue) 3.0 USB port on the computer.

NOTE The AutoPlay window displays the first time the drive is connected to the PC. Close the 
AutoPlay window.
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2 Use the appropriate Windows program to create a system image. See 
Windows Help for more information.

• In Windows 7, click Backup and Restore in the Microsoft Control Panel.

Figure 4 Windows 7 Backup and Restore
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• In Windows 8.1 or Windows 10, click File History in the Microsoft Control 
Panel, then click System Image Backup.

Figure 5 Windows 8.1 File History
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Figure 6 Windows 8.1 System Image Backup

3 Click Create a system image.

4 Click Next.

5 Select the drives you want to include in the backup.

If the OpenLAB product was installed in a location other than C:\ drive, 
you must select that particular drive when asked Which drives do you want to 
include in the backup?
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6 Click Next.

Figure 7 Drives included in the backup

7 Click Start backup.
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8 If you are using Windows 7, create a system repair disc according to the 
Windows instructions.

Figure 8 Create a system repair disc

If you are using Windows 8.1 or Windows 10, use the Recovery program 
from the Microsoft Control Panel and create a recovery drive according to 
the Windows instructions.

9 Close all remaining windows.

10 Eject the newly created Windows Recovery disc.

11 Disconnect the USB drive.

12 Complete the backup Solution Checklist.

13 Keep the USB drive, Windows Recovery disc, completed Backup Solution 
checklist, Backup Guide, and Backup Solution Recovery checklist in a safe 
place.

Start Windows Services
Open Windows Services (services.msc) and Start the services in the order listed 
below. See Services Microsoft Management Console help for more 
information.

1 Agilent OpenLAB Shared Services

2 Agilent OpenLAB Instrument Service

You might need to wait a couple of minutes for the services to fully start.
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Data Backup Procedure
Before the backup, make sure that the Run Queue on all active instruments is 
in idle state (no active run items in the queue) and all Acquisition client 
application are closed. Use Close Connection in the Control Panel to close any 
acquisitions that may still be running.

Stop Windows Services
Open Windows Services and Stop the following services in the order listed 
below. See Microsoft Management Console help for more information on 
stopping these services.

1 Agilent OpenLAB Shared Services

2 Agilent OpenLAB Instrument Service

Figure 9 Stop Services
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Database Backup
1 Launch the Shared Services Maintenance utility and select the Backup and 

Restore tab.

Figure 10 Backup utility

2 Specify the backup directory and retention time.?When a new backup is 
performed, the currently set retention time is used to delete any files older 
than specified.

3 Click Backup.

The backup is placed in the specified backup directory. Backups older than 
the retention time are deleted.

NOTE It is recommended that you use a safe location as the backup directory (for example, a 
thumb drive, a network location, or an external storage device).
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Content Backup
1 Copy the contents of the project folder specified during installation into a 

safe location (for example, a thumb drive, a network location, or an external 
storage device).

Start Windows Services
Open Windows Services (services.msc) and Start the services in the order listed 
below. See Services Microsoft Management Console help for more 
information.

1 Agilent OpenLAB Shared Services

2 Agilent OpenLAB Instrument Service

You might need to wait a couple of minutes for the services to fully start.

Scheduled Backup
To automate the data backup procedure, you can create a batch file 
performing all of the steps above and schedule it to run regularly using 
Windows Task Scheduler.

For your convenience, there is an example provided in the installation folder 
(for example, C:\Program Files (x86)\Agilent Technologies) under \BackupScripts. 
Please examine it carefully and adjust according to your system configuration.

NOTE If you are using Secure Storage, your current Windows user needs to be a member of the 
AgtSfsGroup local group.

NOTE The script needs to be run with administrative privileges and as a user who has access to 
the project folder. If the project folder is secure, the user must be a member of the 
AgtSfsGroup local group.
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Software Restore Procedure
Use this procedure to restore your system from an existing backup system 
image. See the Windows Installation documentation for detailed information.

1 Connect the recovery USB drive to a (blue) USB 3.0 port and insert the 
Windows Recovery DVD in the DVD drive.

2 Start or restart the PC and watch the PC monitor carefully during the 
restart process for the message Press any key to boot from CD or DVD.... Press 
the space bar or any other key when the message appears.

The PC will boot from the DVD.

3 Enter the appropriate information to start the Install Windows program.

4 Select Repair your computer.

5 Specify system recovery options.

• If you are using Windows 7, select the system recovery options according 
to the Windows instructions.

Figure 11 System recovery options

• If you are using Windows 8.1, click Troubleshoot > Advanced Options > 
System Image Recovery > Choose a target operating system.
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6 In the Select a system image backup screen, Use the latest available system image 
is selected by default.

• If the auto-filled information is correct, click Next.

• If no image match is found,

a Select Select a system image and click Next

b Select the appropriate image and click Next.

c Select the date and time and click Next.

7 Select Format and repartition disks and click Next.

8 Click Finish.

9 When the re-image process is complete, restart the system to finish the 
restoration.

Data Recovery Procedure

Stop Windows Services
Open Windows Services and Stop the following services in the order listed 
below. See Microsoft Management Console help for more information on 
stopping these services.

1 Agilent OpenLAB Shared Services

2 Agilent OpenLAB Instrument Service
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Figure 12 Stop Services
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Content Restore
1 Copy the contents of previously preserved project folder to the location 

used at the moment of backup.

2 To restore a system with secured project folder:

a Your current Windows user needs to be a member of the AgtSfsGroup local 
group.

b Open an Administrative command prompt (type cmd into the Windows 
Start Menu search, right click cmd.exe, then select Run as administrator).

c Execute the following commands:

cd C:\Program Files (x86)\Agilent Technologies\OpenLAB 
Services\Server

SecureFolder.exe /group C:\CDSProjects

NOTE In case of a non-default installation, replace C:\Program Files (x86)\Agilent Technologies 
and C:\CDSProjects with the OpenLAB CDS installation path and project folder selected 
during installation.

NOTE Incorrect usage of the SecureFolder.exe utility (specifying folder other than the Project 
Root) can harm other applications or even your operating system, and potentially prevent it 
from starting up.
OpenLAB CDS Workstation 87



7 System Setup and Maintenance
Maintenance Procedures
Database Restore
1 Launch the Shared Services Maintenance utility and select the Backup and 

Restore tab.

Figure 13 Backup utility

2 Click Browse to select the folder with previously created backups.

3 Select the backup you want to restore, and click Restore.

NOTE Backups older than the retention time will not to be shown.
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Start Windows Services
Open Windows Services (services.msc) and Start the services in the order listed 
below. See Services Microsoft Management Console help for more information.

1 Agilent OpenLAB Shared Services

2 Agilent OpenLAB Instrument Service

NOTE In case of a successful restore, the Shared Services service will start automatically.
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Upgrade OpenLAB CDS
License Upgrade 92

Get Upgraded License File 92
Add Upgraded License File to the System 93

Upgrade OpenLAB CDS Workstation to Latest Version 94

This chapter describes the upgrade from OpenLAB CDS 2.0 or 
OpenLAB CDS 2.1 to the current version of OpenLAB CDS.

CAUTION This chapter is not applicable if you are migrating from OpenLAB CDS ChemStation 
Edition.

➔ If you are upgrading from OpenLAB CDS ChemStation Edition be sure to refer to 
the "OpenLAB Migration Tool user guide" prior to configuring OpenLAB CDS.
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Get Upgraded License File
You will need to upgrade your licenses in SubscribeNet prior to upgrading to 
the next version of OpenLAB CDS. We strongly recommend upgrading your 
workstation licenses before upgrading the core software. Standalone 
workstations which are upgraded to the new core software version, without a 
new workstation license, will not work until the new workstation licenses are 
added to the OpenLAB Control Panel.

If you are under SMA subscription, proceed as follows to upgrade your 
licenses:

1 During the following process, you will be prompted in SubscribeNet for the 
host name or MAC address of the workstation where OpenLAB CDS is 
already installed.

To retrieve this hostname and MAC address, open the Control Panel and 
browse to the Administration > Licenses section. Note down the host name 
and use the Copy MAC Address or Save MAC Address function to obtain the 
MAC address.

2 Log into the Agilent Electronic Software and License Delivery 
(https://agilent.subscribenet.com/).

3 Navigate to Manage Licenses by Host. In the Host ID field, enter the previously 
noted MAC address, and click Search.
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If the relevant host name does not appear, you may be managing your 
licenses in multiple SubscribeNet accounts. You will need to log into those 
accounts to upgrade those workstation licenses.

4 If your license(s) are eligible for an upgrade, you will see the Upgrade All 
button. Otherwise you will need to contact your Agilent Sales 
Representative to renew your Software Maintenance Agreement (see “Sales 
and Support Assistance” on page 157). To proceed with generating your 
upgrade license, click the button.

5 On the Upgrade All Licenses for License Host page, review the data, and 
confirm by clicking Upgrade All.

This upgrades the license file to the most current version. SubscribeNet will 
send you an email with a new license file.

6 Put the new license file on your system (see “Add Upgraded License File to 
the System” on page 93.

If you have multiple standalone Workstations, repeat this step for each 
individual workstation.

Note that each workstation's MAC address is the file name. This helps 
identify the correct license file to import into the workstation's Control 
Panel.

Add Upgraded License File to the System
If you have purchased new options, such as additional instrument controls or 
client license and regenerated your license in SubscribeNet, the upgraded 
license file must be re-applied to the system.

1 Start the Control Panel from any machine connected to the system you 
want to install the license for.

2 Navigate to Administration > Licenses.

3 In the ribbon, click Remove License .

4 In the ribbon, click Add License .

5 Browse to and open the license file saved from the license generation 
process in SubscribeNet.

6 Restart the following Windows services:

• Agilent OpenLAB License Server

• Agilent OpenLAB Licensing Support
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Upgrade OpenLAB CDS Workstation to Latest Version

You can upgrade an OpenLAB CDS standalone workstation to the latest 
version using the OpenLAB CDS Installation Wizard.

1 Run the Setup.exe file from the installation medium as a user with 
administrative rights.

2 Select OpenLAB CDS.

3 In the OpenLAB CDS Installer, select the Installation screen.

4 Click Install/Upgrade.

5 Provide your OpenLAB CDS credentials.

6 Click Upgrade.

7 In the Upgrade screen, click Next to start the reconfiguration.

8 In the Configuration screen, click Next to start the upgrade.

9 On the Finish page, keep the Reboot check box selected, and click Finish.

10 If you use a GC/MS instrument: Upgrade the GC/MS firmware to the latest 
revision. The upgrade is required for the GC/MS software to work properly 
with OpenLAB CDS 2.2.

For more information on driver upgrades, see “Install or Upgrade Driver 
Software” on page 25.

It is recommended that you reconfigure the instrument in the Control 
Panel.
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This chapter describes the uninstallation of the software.
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Uninstall OpenLAB CDS
Uninstall OpenLAB CDS

1 Log in as an administrator.

2 In the Microsoft Control Panel, open Programs and Features.

3 To uninstall OpenLAB CDS double-click Agilent OpenLAB CDS.

The Agilent Uninstallation Wizard opens. In the wizard, click Uninstall.

4 After uninstalling OpenLAB CDS, reboot.
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Uninstall OpenLAB Help and Learning Only

If you installed OpenLAB Help and Learning only, follow this procedure to 
uninstall it.

1 Insert the USB media, right-click the setup.exe file, and run it as 
administrator. Alternatively, copy the content of the USB media to a 
network share, and run the setup.exe file from there.

NOTE If User Account Control (UAC) is switched on, this step requires active confirmation to 
continue.
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Uninstall OpenLAB Help and Learning Only
2 On the start screen, select OpenLAB CDS, and click OK.
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3 On the Documentation page, select Install OpenLAB Help and Learning Only.

The Agilent OpenLAB CDS Help and Learning wizard opens.
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Uninstall OpenLAB Help and Learning Only
4 Select the correct language, then click Next.
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Uninstall OpenLAB Help and Learning Only
5 Click Remove.

The wizard removes OpenLAB Help and Learning from your system.
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Uninstall OpenLAB Help and Learning Only
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Hardware and Software Requirements

General Software Requirements

The following software is recommended to be installed or enabled on any 
supported operating system prior to installing OpenLAB CDS components. It 
is not required for the system to function correctly. You will need it, however, 
to view videos or PDF manuals in OpenLAB Help & Learning.

• Adobe Flash Player 17

• Adobe Reader XI

Component Details

.NET framework • .NET 3.5.1 must be enabled on systems running on Windows 8.1, 
Windows 10, or Windows Server 2012 R2.
and

• .NET 4.6.2 or above (if needed, it will be installed automatically 
by the OpenLAB Installer)

Web browser • Internet Explorer 11
• Google Chrome 40 or higher

Antivirus software1

1 The listed antivirus software has been tested and is recommended by Agilent. Check with your Agi-
lent service person in case you want to use other software.

• Symantec Endpoint Protection
• Trend Micro
• Microsoft Security Essentials
• McAfee

NOTE If these tools are not installed on your system, you can install them from the OpenLAB 
CDS Installer.
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Language Compatibility
The English version of OpenLAB CDS is validated on Windows English and 
Western European language operating systems. Regional settings (locales) can 
be adjusted as required. In a Client/Server system make sure regional settings 
are the same for the server, AIC and clients. 

Localized versions of OpenLAB CDS are supported on localized language 
versions of Windows, using default system fonts:

• Chinese: Microsoft YaHei

• Japanese: Meiryo UI

• Brazilian Portuguese: Calibri

OpenLAB CDS can run on other language versions of Windows as well, but the 
user interface will be English.

Non-localized instrument drivers are supported and will appear in English 
even when running localized versions of OpenLAB CDS.

Disk Space
Disk space requirements should be adjusted based on the number and type of 
instruments and archival periodicity. Agilent recommends providing enough 
disk space for one year of lab operation, in addition to the operating system 
and OpenLAB CDS requirements.

Table 4 Typical expected file sizes

Run time Description Expected data size

2D data 60 min 10 Hz, 2 channel data 300-700 KB

3D data 60 min 10 Hz, 5 channel data, 
plus spectra at 1 nm 
resolution from 200 to 
400 nm

100-300 MB

LC/MS data (SQ) 60 min Scan mode 20-40 MB

GC/MS data (SQ) 60 min Scan mode 50-300 MB

GC/MS data (SQ) 60 min SIM mode with 2 ions 1-3 MB
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Hardware

Number of Instruments
With the standard configurations you can configure any number of 
instruments that sums up to 4  instrument points per OpenLAB CDS 
Workstation.

With the VL configurations you can configure only 1 instrument with up to 2 
instrument points per OpenLAB CDS VL Workstation.

Instrument points are an indicator for the data stream that needs to be 
managed, and thus also for the required hardware and software. Instruments 
count as follows:

Table 5 Tested and recommended hardware configuration for an OpenLAB CDS Work-
station

Item Requirement

Processor speed (CPU) Intel® Xeon E3, 3.2 GHz, 8MB Cache, 4 Core, 
Hyper Threading, Intel® vPro TM Technology, 
Intel® HD Graphics, or equivalent

Physical memory (RAM) 8 GB

Hard disk 1 x 500 GB SATA 7200 RPM
See Table 4 on page 105

Graphic Resolution 1600 x 900

RS-232 port 1 serial port (certain instruments require a 
serial port)

USB port 1 USB port required for installation. 

LAN card Integrated Intel® I217LM PCIe GbE Controller

GC: 1 instrument point

LC: 1 instrument point

3D LC: 2 instrument points

GC/MS: 3 instrument points

LC/MS: 3 instrument points

3D LC/MS 4 instrument points
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Table 6 Supported operating systems for a workstation

Operating System Details

Windows • Windows 10, Enterprise or Pro, 64bit
or

• Windows 7 SP1, Enterprise or Professional, 64bit
or

• Windows 8.1, Enterprise or Professional, 64bit
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This chapter describes the network requirements that must be met in order to 
support the environmental computing needs of an OpenLAB Chromatography 
Data System (CDS).

Introduction
OpenLAB CDS systems rely on network infrastructure in order to support the 
communication between various system nodes. This communication is based 
on standard TCP/IP protocols. In order to provide optimum performance and 
uptime, the network must meet design criteria for available bandwidth, IP 
address assignment, name resolution and appropriate isolation of the lab 
subnet from the corporate network.

LAN Connectivity
When using LAN communications to connect workstations or instrument 
controllers to an instrument, use one of these methods:

• Connect via an isolated switch using standard CAT-5 network cabling

• LAN communication hardware should be 100/1000 mbps (or higher) speed 
capable.

• NIC teaming1: LAN cards should not be teamed on workstations, 
instrument controllers, or clients.

• LAN communication must be on the same subnet as instruments, and 
preferably on the same segment.

1 Network Interface Card (NIC) teaming is also known as Load Balancing and Failover (LBFO)

NOTE See the separate driver installation guides for further information regarding vendor specific 
instrument connections. GPIB or RS232 might be required.
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LAN Power Management
Avoid data capture or transfer interruptions in your data acquisition system 
by making LAN communication cards available for instrument and system 
component communications.

Windows may be set to turn instruments/components off to save power 
while sleeping or hibernating. To change this setting:

1 In the Microsoft Control Panel, open the Network and Sharing Center1.

2 Select Change adapter settings. Right-click Local Area Connection > Properties > 
Configure.

3 Select the Power Management tab.

4 Clear the Allow the computer to turn off this device to save power check box.

1 View the items by icon to see a list of all items.
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Firewall Settings
If you are using a third party firewall or antivirus software on the network 
where OpenLAB CDS is installed, open these firewall ports to allow 
communication between the system components of OpenLAB CDS. These 
apply to workstations as well as to Client/Server systems as component 
communications rely on these communication channels:

Port 21: GC MSD - Firmware Installation (FTP) 

Port 23: GC MSD - Firmware Installation (Telnet)

Port 25: Agilent OpenLAB send eMail (SMTP)

Ports 67 and 68: BootP Server communications

Port 80: GC MSD - Embedded Web Server HTTP
McAfee

Ports 111, 1007, 
1024-1025:

GC MSD - Instrument Control (Proprietary/SunRPC/TCP)

Ports 2883-2885: GC MSD - Instrument Control (Proprietary/SunRPC/TCP)

Port 2886: Agilent OpenLAB Automation Services
GC MSD - Instrument Control (Proprietary/SunRPC/TCP)

Ports 3068 and 3071: GC MSD - Instrument Control (Proprietary/SunRPC/TCP)

Port 3424: Transfer of diagnostics information between OpenLAB CDS system 
components

Port 4879: Required for Headspace events

Port 5813: GC MSD - Firmware Installation (ICMP/Ping)

Port 5973: GC MSD - Instrument Control (Proprietary/SunRPC/TCP) 

Port 6570: SubscribeNet: active retrieval and release of product licenses

Port 6577: Communications of OpenLAB CDS administrative information. This 
includes instrument and run status, active trace data, and global 
configurations.

Port 6624: Agilent OpenLAB REST API 

Ports 7972 and 7973: GC MSD - Instrument Control

Ports 7980-7983: GC MSD - Instrument Control - RSlick (TCP)
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The OpenLAB CDS installer will automatically open these ports on an enabled 
Windows firewall during installation.

Domain Requirements
Domains support the flow of information and user access rights across 
machines in the network. This means that all machines and instruments 
within the networked OpenLAB CDS system must reside within the same 
domain or have the appropriate cross domain trusts to allow name based 
communications between all components in the system. In the case of a 
workstation installation, domains are only relevant if you are using a Windows 
domain-based authentication model. In this case the workstation or client 
must always be able to communicate with domain components in order to 
function as expected. 

Port 8084: Agilent OpenLAB Licensing support

Ports 8085-8089: Alternative to port 8084 if that port is in use by another page or 
process

Port 8090: Hosts the viewing page of current license grants and consumptions 
found in the Control Panel administration interface

Ports 9001-9002: Communication with instruments and shared servers

Port 9110: Instrument comm (GC/LC)

Port 9753: Task-based messaging communication between acquisition 
controllers and chromatography clients
Configurable during AIC registration. It is required that all ports 
designated during AIC registration be opened for access.

Ports 10000-10010: Status and acquisition communication with Agilent 7890 GCs

Ports 27000-27009: Communication of license availability

Port 55065: GC MSD - Instrument Control - RSlick (TCP)

Dynamic Ports: Temporary communications between clients and instrument 
controllers
The ports used depend on the operating system in use and are 
configurable. Refer to the operating system documentation for more 
information.
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Installing OpenLAB CDS will apply network exceptions to the Windows 
firewall under the domain profile to result in a functional system. The 
components necessary to support OpenLAB CDS on a domain are:

• Domain controller — broadcasts the domain name and negotiates access to 
machines.

• Domain name server (DNS) — maintains records of what hostnames belong 
to which IP on the network. This component is always required for effective 
components communications in networked systems.

• Active directory — maintains the list of users and their access rights on the 
domain.

The domain components above host a variety of services and settings that 
must be configured appropriately to allow communication across machines. 
The following services and settings will need to be configured to fit your 
domain. Your internal IT group is responsible for proper configuration of any 
custom domain solutions. These include settings for:

• Lookup zones and hostnames

• Group and security policies

• Subnet masks and Virtual LANs

• IP reservation (static or DHCP)

Environments with Proxy Servers
The OpenLAB server must be accessible via http or https in the network. If you 
use proxy servers, verify that they can be accessed. If required, adjust the 
proxy settings.

NOTE The domain name server (DNS) must be able to resolve the IPv4 address of all instrument 
controllers and instruments. Any unresolved instrument controller or instrument will 
disrupt the functionality of OpenLAB resulting in errors or delays. IPv6 is not supported 
and must be deactivated.

NOTE OpenLAB CDS components must not be installed on the same machine as the domain 
controller.
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Configure Windows 10
[MUST] 1 System (Microsoft Control Panel)1: Register Windows with Microsoft.

2 File Explorer Options (Microsoft Control Panel): In the View tab:

• Select Always show menus.

• Select Display the full path in the title bar.

• Clear Hide extensions for known file types.

• Clear Use Sharing Wizard.

[MUST] 3 Start > Settings > Update and Security:

a Click Check for updates to check for updates and apply all critical security 
patches.

Before proceeding, ensure that all updates are downloaded and installed. 
Ensure that there is no reboot pending.

b Click Advanced options.

c Select the Defer feature updates check box.

d Click Choose how updates are delivered.

e Turn off Updates from more than one place.

[MUST] 4 Settings for updates: Windows Update service MUST NOT be running during 
installation.

[MUST] 5 Indexing Options (Microsoft Control Panel): Disable indexing.

Click the Modify button. Clear all drives and locations. 

[MUST] 6 Start > Settings > System > Tablet Mode: For When I sign in, select Use desktop 
mode.

1 View the items by icon to see a list of all items.
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[MUST] 7 Power Options (Microsoft Control Panel):

a As preferred plan select High performance

b Click Change Plan settings

c Set the option Put the computer to sleep to Never.

d Click Change advanced power settings. 

e Open the nodes for Hard disk > Turn off hard disk after.

f Set the Minutes to 0 (=Never).

[MUST] 8 Start > Settings > System > Offline Maps:: Turn Metered connections and Map 
updates off.

[MUST] 9 Administrative Tools (Microsoft Control Panel): Configure security options:

a Double-click Local Security Policy.

b Navigate to Security Settings > Local Policies > Security Options

c Double-click the following policy listed in the right hand panel: Network 
Access: Sharing and security model for local accounts

d In the displayed dialog select the following item from the drop-down list: 
Classic - local users authenticate as themselves

[MUST] 10 Start > Settings > System and Security:

a Click Change Windows SmartScreen settings.

Select Don't do anything (turn off Windows SmartScreen).

[MUST] 11 Date and Time (Microsoft Control Panel): Choose the time zone of your 
machine's location.

[MUST] 12 Network and Sharing Center (Microsoft Control Panel):

a Select Change adapter settings. Right-click Local Area Connection > Properties 
> Configure.

b On the Power Management tab, clear all check boxes. 
114 OpenLAB CDS Workstation



Appendix 10
Operating System Configuration
[MUST] 13 Programs and Features (Microsoft Control Panel):

a Click Turn Windows features on or off.

b Enable .NET 3.5 by selecting the .NET Framework 3.5 (includes .NET 2.0 and 
3.0) check box.

This option requires an internet connection.

c To make sure that all the net.tcp components are properly initialized, 
Non-HTTP activation must be enabled. Expand the .NET Framework 3.5 
(includes .NET 2.0 and 3.0) node and select the Windows Communication 
Foundation Non-HTTP Activation check box.

d Select the .NET Framework 4.6 Advanced Services check box. Use the default 
values for sub items.

e Select the Internet Explorer 11 check box.

f Select the Telnet Client check box.

g Select the TFTP Client check box.

h Reboot the PC.

[MUST] 14 Start > Settings > System > Default Apps: Select Internet Explorer as default 
Web browser.

Do not use Edge, it is not supported. Unpin Edge from the task bar.

[MUST] 15 Disable Compatibility View in Internet Explorer.

a Open Internet Explorer.

b Click the Tools menu, and then click Compatibility View Settings. 

c Clear the Display intranet sites in Compatibility View check box.

[MUST] 16 Enable the navigation pane:

Open Windows Explorer, then select View > Navigation pane from the ribbon 
and make sure that Navigation pane is selected.

NOTE If this procedure does not work as expected, or the computer has no internet access, 
install .NET 3.5 from the Windows installation media (see details for Windows 10 under 
https://support.microsoft.com/en-us/kb/2734782). If you do not have installation media, 
create them as described under 
https://www.microsoft.com/en-us/software-download/windows10.
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[PERFORMANCE] 17 System (Microsoft Control Panel): Change performance options:

a Click Advanced system settings.

b On the Advanced tab > Performance click Settings.

c On the Visual Effects tab, select Adjust for best performance.

d Under Custom, select the following check boxes for better usability:

• Smooth edges of screen fonts

• Show shadows under mouse pointer

• Show shadows under windows

[PERFORMANCE] 18 Start > Settings > Personalization > Colors: Turn  Make Start, taskbar, and action 
center transparent off.

[PERFORMANCE] 19 System (Microsoft Control Panel): Change system properties:

a Click Advanced system settings.

b On the Advanced tab > Performance click Settings. 

• Advanced tab > Virtual Memory: For optimum performance use the 
Change button to adjust the paging file size to a value of 2 to 3 times of 
the physical RAM on the PC. If possible locate the paging file on a 
drive different from the system installation drive.

• Data Execution Prevention tab: Select Turn on DEP for essential Windows 
programs and services only.

c Advanced > Startup and Recovery > Settings button:

• System startup section: 

Change both Time to display ... fields from 30 to 3 sec. 

• System failure section: 

Select Automatically restart, in the Write debugging information section 
select Kernel memory dump from the drop-down list.

d System Protection tab

Make sure that Protection is turned off. If required, click Configure and 
select Disable system protection.

e Remote tab

• In the Remote Assistance section, clear the check box Allow Remote 
Assistance connections to this computer. 

• In the Remote Desktop section, select Don't allow connections to this 
computer. 
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[OPTIONAL] 20 Start > Settings > Personalization: Disable advertising info:

a On the Lock screen page:

• Under Background, select Picture or Slideshow.

• Turn off Get fun facts, tips, tricks, and more on your lock screen.

• Turn off Show lock screen background picture on the sign-in screen.

b On the Start page:

Turn off Occasionally show suggestions in Start.

[OPTIONAL] 21 Start > Settings > Privacy:

a On the General page, turn off the following:

• Let apps use my advertising ID

• Turn on SmartScreen Filter to check web content

• Send Microsoft info about how I write

b On the Location page, turn off Location.

[OPTIONAL] 22 Start > search for 'gpedit.msc': Welcome Center:

a Navigate to Local Computer Policy > Computer Configuration > Administrative 
Templates > System > Logon.

b Set Don't display the Getting Started welcome screen at logon to Enabled.

[OPTIONAL] 23 Recycle Bin Properties: (right-click on desktop icon Recycle Bin) Select the 
following options: 

• Custom size: Select a size corresponding to approximately 10% of the 
complete disk space for the drive.

• Select Display delete confirmation dialog.

Repeat these steps for all drives of your computer.

24 Region (Microsoft Control Panel): Language for non-Unicode programs:

On the Administrative tab, click Change system locale.... From the drop down 
list, select English (United States).

[OPTIONAL] 25 Right-click the taskbar to open the Taskbar and Start Menu Properties dialog. In 
the Taskbar tab, under Taskbar buttons select Combine when taskbar is full.

This will simplify switching between open CDS instances.

NOTE Do not the change system locale if you are using an English, Portuguese, Japanese or 
Chinese Operating System.
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Configure Windows 8.1
[MUST] 1 System (Microsoft Control Panel)1: Register Windows with Microsoft.

[MUST] 2 Folder Options (Microsoft Control Panel): In the View tab,

• Select Always show menus.

• Select Display the full path in the title bar.

• Clear Hide extensions for known file types.

• Clear Use Sharing Wizard.

[MUST] 3 Windows Update (Microsoft Control Panel):

Click Check for updates to check for updates and apply all critical security 
patches.

[MUST] 4 Windows Update (Microsoft Control Panel): Change the settings for updates:

Click Change settings. In the Important updates section, select Never check for 
updates. Clear the other update options. 

[MUST] 5 Indexing Options (Microsoft Control Panel): Disable indexing.

Click the Modify button. Clear all drives and locations. 

[MUST] 6 Power Options (Microsoft Control Panel):

a As preferred plan select High performance

b Click Change Plan settings

c Set the option Put the computer to sleep to Never.

d Click Change advanced power settings. 

e Open the nodes for Hard disk > Turn off hard disk after.

f Set the Minutes to 0 (=Never).

1 View the items by icon to see a list of all items.

NOTE This setting is required during installation of OpenLAB CDS.

On clients in a client/server system, you may activate automatic updates again after 
finishing the installation.

On Agilent Instrument Controllers (AIC) or standalone workstations, keep the Never check 
for updates setting. This setting is important to avoid data loss due to system reboot 
during data acquisition.
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[MUST] 7 Administrative Tools (Microsoft Control Panel): Configure security options:

a Double-click Local Security Policy.

b Navigate to Security Settings > Local Policies > Security Options

c Double-click the following policy listed in the right hand panel: Network 
Access: Sharing and security model for local accounts

d In the displayed dialog select the following item from the drop-down list: 
Classic - local users authenticate as themselves

[MUST] 8 Date and Time (Microsoft Control Panel): Choose the time zone of your 
machine's location.

[MUST] 9 Network and Sharing Center (Microsoft Control Panel):

a Select Change adapter settings. Right-click Local Area Connection > Properties 
> Configure.

b On the Power Management tab, clear all check boxes. 

[MUST] 10 .NET settings (Go to Control Panel > Programs and Features):

a Click Turn Windows features on or off.

b Enable .NET 3.5 by selecting the .NET Framework 3.5 (includes .NET 2.0 and 
3.0) check box.

This option requires an internet connection.

c To make sure that all the net.tcp components are properly initialized, 
Non-HTTP activation must be enabled. Expand the .NET Framework 3.5 
(includes .NET 2.0 and 3.0) node and select the Windows Communication 
Foundation Non-HTTP Activation check box.

[MUST] 11 Disable Compatibility View in Internet Explorer.

a Open Internet Explorer.

b Click the Tools menu, and then click Compatibility View Settings. 

c Clear the Display intranet sites in Compatibility View check box.

NOTE If this procedure does not work as expected, or the computer has no internet access, 
install .NET 3.5 from the Windows installation media (see Method 3 under 
https://support.microsoft.com/en-us/kb/2734782). If you do not have installation media, 
create them as described under 
http://windows.microsoft.com/en-US/windows-8/create-reset-refresh-media?woldogcb
=0.
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[PERFORMANCE] 12 System (Microsoft Control Panel): Change performance options:

a Click Advanced system settings.

b On the Advanced tab > Performance click Settings.

c On the Visual Effects tab, select Adjust for best performance.

d Under Custom, select the following check boxes for better usability:

• Smooth edges of screen fonts

• Show shadows under mouse pointer

• Show shadows under windows

[PERFORMANCE] 13 System (Microsoft Control Panel): Change system properties:

a Click Advanced system settings.

b On the Advanced tab > Performance click Settings. 

• Advanced tab > Virtual Memory: For optimum performance use the 
Change button to adjust the paging file size to a value of 2 to 3 times of 
the physical RAM on the PC. If possible locate the paging file on a 
drive different from the system installation drive.

• Data Execution Prevention tab: Select Turn on DEP for essential Windows 
programs and services only.

c Advanced > Startup and Recovery > Settings button:

• System startup section: 

Change both Time to display ... fields from 30 to 3 sec. 

• System failure section: 

Select Automatically restart, in the Write debugging information section 
select Kernel memory dump from the drop-down list.

[OPTIONAL] 14 Start > search for 'gpedit.msc': Welcome Center:

a Navigate to Local Computer Policy > Computer Configuration > Administrative 
Templates > System > Logon.

b Set Don't display the Getting Started welcome screen at logon to Enabled.
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[OPTIONAL] 15 Recycle Bin Properties: (right-click on desktop icon Recycle Bin) Select the 
following options: 

• Custom size: Select a size corresponding to approximately 10% of the 
complete disk space for the drive.

• Select Display delete confirmation dialog.

Repeat these steps for all drives of your computer.

16 Region (Microsoft Control Panel): Language for non-Unicode programs:

On the Administrative tab, click Change system locale.... From the drop down 
list, select English (United States).

NOTE Do not the change system locale if you are using an English, Portuguese, Japanese or 
Chinese Operating System.
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Configure Windows 7
[MUST] 1 System (Microsoft Control Panel)1: Register Windows with Microsoft.

[MUST] 2 Folder Options (Microsoft Control Panel): In the View tab,

• Select Always show menus.

• Select Display the full path in the title bar.

• Clear Hide extensions for known file types.

• Clear Use Sharing Wizard.

[MUST] 3 Windows Update (Microsoft Control Panel):

Click Check for updates to check for updates and apply all critical security 
patches.

[MUST] 4 Windows Update (Microsoft Control Panel): Change the settings for updates:

Click Change settings. In the Important updates section, select Never check for 
updates. Clear the other update options. 

[MUST] 5 Indexing Options (Microsoft Control Panel): Disable indexing.

Click the Modify button. Clear all drives and locations. 

[MUST] 6 Only for Standalone Workstations that do not belong to a domain: 
Start > search for 'gpedit.msc': Windows logon options:

a Navigate to Local Computer Policy > Computer Configuration > Administrative 
Templates > System > Logon.

b Set Hide entry points for Fast User Switching and Always use classic logon to 
Enabled.

1 View the items by icon to see a list of all items.

NOTE This setting is required during installation of OpenLAB CDS.

On clients in a client/server system, you may activate automatic updates again after 
finishing the installation.

On Agilent Instrument Controllers (AIC) or standalone workstations, keep the Never check 
for updates setting. This setting is important to avoid data loss due to system reboot 
during data acquisition.
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[MUST] 7 Power Options (Microsoft Control Panel):

a As preferred plan select High performance

b Click Change Plan settings

c Set the option Put the computer to sleep to Never.

d Click Change advanced power settings. 

e Open the nodes for Hard disk > Turn off hard disk after.

f Set the Minutes to 0 (=Never).

[MUST] 8 Administrative Tools (Microsoft Control Panel): Configure security options:

a Double-click Local Security Policy.

b Navigate to Security Settings > Local Policies > Security Options

c Double-click the following policy listed in the right hand panel: Network 
Access: Sharing and security model for local accounts

d In the displayed dialog select the following item from the drop-down list: 
Classic - local users authenticate as themselves

[MUST] 9 Date and Time (Microsoft Control Panel): Choose the time zone of your 
machine's location.

[MUST] 10 Network and Sharing Center (Microsoft Control Panel):

a Select Change adapter settings. Right-click Local Area Connection > Properties 
> Configure.

b On the Power Management tab, clear all check boxes. 

[MUST] 11 Programs and Features (Microsoft Control Panel):

a Click Turn Windows features on or off.

b Expand the Microsoft .NET Framework 3.5.1 node and select the Windows 
Communication Foundation Non-HTTP Activation check box.

c Select the Internet Explorer 11 check box.

d Select the Telnet Client check box.

e Select the TFTP Client check box.

f Reboot the PC.
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[MUST] 12 Disable Compatibility View in Internet Explorer.

a Open Internet Explorer.

b Click the Tools menu, and then click Compatibility View Settings. 

c Clear the Display intranet sites in Compatibility View check box.

[PERFORMANCE] 13 System (Microsoft Control Panel): Change performance options:

a Click Advanced system settings.

b On the Advanced tab > Performance click Settings.

c On the Visual Effects tab, select Adjust for best performance.

d Under Custom, select the following check boxes for better usability:

• Smooth edges of screen fonts

• Show shadows under mouse pointer

• Show shadows under windows

[PERFORMANCE] 14 System (Microsoft Control Panel): Change system properties:

a Click Advanced system settings.

b On the Advanced tab > Performance click Settings. 

• Advanced tab > Virtual Memory: For optimum performance use the 
Change button to adjust the paging file size to a value of 2 to 3 times of 
the physical RAM on the PC. If possible locate the paging file on a 
drive different from the system installation drive.

• Data Execution Prevention tab: Select Turn on DEP for essential Windows 
programs and services only.

c Advanced > Startup and Recovery > Settings button:

• System startup section: 

Change both Time to display ... fields from 30 to 3 sec. 

• System failure section: 

Select Automatically restart, in the Write debugging information section 
select Kernel memory dump from the drop-down list.
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[OPTIONAL] 15 General Layout: (right-click Start  > Properties)

a Start Menu Tab: In the Privacy section select both items

b Start Menu Tab > Customize button: In Customize Start Menu dialog: 

• Clear the following option:

• Favorites menu

• Select the following options:

• Computer Display as a link

• Connect To

• Control Panel: Display as a menu

• Default Programs

• Devices and Printers

• Documents: Display as a link

• Enable context menus and dragging and dropping

• Games: Don't display this item

• Help

• Highlight newly installed programs

• Music: Don't display this item

• Network

• Open submenus when I pause on them with the mouse pointer

• Personal folder: Display as a link

• Pictures: Display as a link

• Run command

• Search other files and libraries Search with public folders

• Search programs and Control Panel

• Sort All Programs menu by name

• System administrative tools: Display on the All Programs menu and in 
the Start menu

• Use large icons
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[OPTIONAL] 16 Start > search for 'gpedit.msc': Welcome Center:

a Navigate to Local Computer Policy > Computer Configuration > Administrative 
Templates > System > Logon.

b Set Don't display the Getting Started welcome screen at logon to Enabled.

[OPTIONAL] 17 Recycle Bin Properties: (right-click on desktop icon Recycle Bin) Select the 
following options: 

• Custom size: Select a size corresponding to approximately 10% of the 
complete disk space for the drive.

• Select Display delete confirmation dialog.

Repeat these steps for all drives of your computer.

[OPTIONAL] 18 Region and Language (Microsoft Control Panel): Set the language for 
non-Unicode programs.

On the Administrative tab, click Change system locale.... From the drop down 
list, select English (United States).

NOTE Do not the change system locale if you are using an English, Portuguese, Japanese or 
Chinese Operating System.
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This section provides information on the instruments supported by the 
current revision of OpenLAB CDS and the required respective instrument 
drivers and firmware revisions. 

RC.NET Drivers compatible with OpenLAB CDS
OpenLAB CDS can control instruments and modules that use RC.NET based 
driver software only. 

Agilent and other vendors may release RC.net drivers independent of the 
OpenLAB CDS releases. Agilent recommends always using the most recent 
firmware revisions which include latest firmware features and improvements. 
Agilent driver software is forward compatible with respect to firmware, i.e. 
the firmware can be updated without the need of updating the driver or CDS.

More information on instrument drivers and firmware is available in the 
respective RC.net driver release notes.
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The following Agilent instrument driver software revisions are part of the 
OpenLAB CDS 2.2 software package, and are installed by default with the 
software: 

Additional RC.NET instrument drivers are supported with OpenLAB CDS. You 
will need to install them separately (see section Install or Upgrade Driver 
Software in chapter 1 of your Workstation or Client Server guide). 

Supported Agilent drivers are listed in the following table with their minimum 
software revisions.

Table 7 Agilent driver packages shipped and installed with OpenLAB CDS 2.2

RC.net Instrument Driver Driver Software Revision

Agilent LC A.02.16

Agilent LC/MS SQ A.01.02

Agilent GC B.01.02

Headspace B.01.07

Agilent GC/MS SQ A.01.01

Agilent 35900E A/D 2.3.0

Agilent SS420X A.01.01.64

Agilent Data Player A.01.02.010

Pal 3 A.01.03

Pal-xt B.01.08

Table 8 Other compatible Agilent Instrument Drivers (on the installation medium)

RC.net Instrument Driver Driver Software Revision

CTC PAL3 A.01.03

PAL XT B.01.08

ELSD A.01.07

Agilent 490 Micro GC B.01.12

Agilent Headspace B.01.07.2
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Third Party Drivers
OpenLAB CDS 2.2 supports selected third party instruments. See Table 15 on 
page 143 for more details. 

Always install dedicated RC.net drivers available from SubscribeNet at 
OpenLAB CDS > OpenLAB 3rd-Party Instrument drivers.

Agilent LC and LC/MS

Agilent LC 
Most Agilent LC Modules can be controlled with the current version of 
OpenLAB CDS. LC driver release A.02.14 has been tested with this revision 
and is installed by default with the software. 

Recommended Firmware
Agilent recommends using current LC firmware sets with your OpenLAB CDS. 
The latest LC firmware sets are 7.01, 6.50, and 6.30. Firmware Set 7.01 can be 
downloaded from 
http://www.agilent.com/en-us/firmwareDownload?whid=99818. 

NOTE LC and CE firmware revisions are grouped into sets for each module or system. Firmware 
sets include just the latest firmware of each module. 

Modules combined into one LC instrument always need to have firmware from the same 
set. Firmware of one set is fully compatible with your CDS that supports this firmware set. 
However, if one module uses a firmware revision lower that the specified Minimum 
Firmware Revision some functionality might not be supported. 

Do not mix firmware revisions from one set with older or newer sets. Firmware is not 
tested across set borders!
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You need to upgrade all existing modules to the latest version only if

• you add a new LC module to the existing system (recommended).

• one of the existing modules requires an upgrade due to a bug fix solved 
with the latest release.

For more information on downloading the current LC firmware, please refer 
to the Agilent website atLC Firmware News and Downloads and Firmware 
Update Tools & Procedures (, ).

The tables below “Supported LC modules” on page 131 list the supported LC 
modules with the minimum required firmware. Please note that using some 
driver features like valve-thermostat clusters and new temperature control 
modes require firmware updates beyond the minimum required firmware for 
related modules. For more information please refer to the respective release 
notes. The current Release Note for Agilent LC and CE drivers Revision 
A.02.16LC Driver Release Note A0216.pdf is available in the Docs/Enu folder of 
the OpenLAB CDS media.

Device Recommended 
Firmware

Agilent 1100 Series, 1200 Series and 1200 Infinity A.07.01 or later

Agilent 1200 Series, 1200 Infinity and 1120 Compact LC B.07.20 or later

Agilent 1200 Infinity Hosted Modules C.07.20 or later

Agilent 1260/1290 Infinity II Modules D.07.20 or later
130 OpenLAB CDS Workstation



Appendix 10
Instrument Connections
Supported LC modules

Agilent LC - Sampling Systems

HINT Check for the product number at the lower right of each module or system.

Product 
Number

Module Name Minimum Firmware 
Revision

G1313A 1100 Series Standard Autosampler A.06.10 

G1329A 1100 Series Standard Autosampler A.06.10 

G1329B 1260 Infinity Standard Autosampler A.06.10

G1330A/B 1200 Thermostat n/a

G1367A 1100 Series Well-plate Sampler A.06.31

G1367B 1200 Series High Performance Autosampler A.06.31

G1367C 1200 Series High Performance Autosampler SL A.06.31

G1367D 1200 Series High Performance Autosampler SL+ A.06.31

G1367E 1260 Infinity High Performance Autosampler A.06.32

G4226A 1290 Infinity Autosampler A.06.31

G4303A 1260 Infinity SFC standard autosampler A.06.54

G4767A 1260 Infinity II SFC Multisampler

G5667A 1260 Bio-innert High Performance Sampler A.06.32

G5668A 1260 Infinity II Bio-inert Multisampler D.07.01

G7129A 1260 Infinity Vialsampler D.06.76

G7129B 1290 Infinity II Vialsampler D.06.76

G7167A 1260 Infinity II Multisampler D.06.75

G7167B 1290 Infinity II Multisampler D.06.75
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Table 9 Agilent CTC PAL Autosampler with Agilent LC

Product 
Number

Module Name Minimum Firmware 
Revision

G4277A Agilent 1290 Infinity LC Injector HTS Agilent 2.6.8 or 4.1.5

G4278A Agilent 1290 Infinity LC Injector HTC Agilent 2.6.8 or 4.1.5

G4270-CTC HTC PAL Auto sampler Agilent 2.6.8 or 4.1.5

G4271-CTC HTS PAL Auto sampler Agilent 2.6.8 or 4.1.5
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Agilent LC – Pumps

Product 
Number

Module Name Minimum Firmware 
Revision

G1310A 1100 Series Isocratic Pump A.06.10

G1310B 1260 Infinity Isocratic Pump A.06.32

G1311A 1100 Series Quaternary Pump 1

1 Pump valve clusters are possible for marked pumps with up to 2 valves of type G1160A and/or 
G1170A 

A.06.10

G1311B 1260 Infinity Quaternary Pump 1 A.06.10

G1311C 1260 Infinity Quaternary Pump VL 1 A.06.32

G1312A 1260 Infinity Binary Pump 1 A.06.10

G1312B 1260 Infinity Binary Pump SL 1 A.06.10

G1312C 1260 Infinity Binary Pump VL 1 A.06.32

G4204A 1290 Quaternary Pump 1 B.06.50

G4220A 1290 Infinity Binary Pump 1 B.06.23

G4220B 1290 Infinity Binary Pump B.06.43 

G4302A 1260 Infinity SFC Binary Pump 1 A.06.10

G4782A 1260 Infinity II SFC Binary Pump

G5611A 1260 Infinity Bio-inert Quaternary Pump1 A.06.10

G5654A 1260 Infinity II Bio Quat Pump D.07.01

G7104A 1290 Infinity II Flexible Pump B.06.71

G7110B 1260 Infinity II Iso. Pump D.07.01

G7111A 1260 Infinity II Quat. Pump VL D.07.01

G7111B 1260 Infinity II Quat. Pump D.07.01

G7112B 1260 Infinity II Bin. Pump D.07.01

G7120A 1290 Infinity II High Speed Pump B.06.71
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Agilent LC – Detectors

Product 
Number

Module Name Minimum Firmware 
Revision

G1316A 1260 Infinity Thermostatted Column Compartment A.06.10

G1316B 1200 Series Column Compartment SL A.06.10

G1316C 1200 Series Thermostatted Column Compartment SL 1

1 Cluster with up to three G1316C with integrated 8pos/9port valves (products G4230A/B). Mini-
mum two G1316C TCCs, the third TCC can be a G1316A, B or C.

A.06.14

G7116A 1260 Infinity II Multicolumn Thermostat B.07.01

G7116B 1290 Infinity II Multicolumn Thermostat B.06.75

G7130A Integrated Column Compartment ICC D.06.76

VTC Valve 
Thermostat 
Cluster

Combinations of G7116B, G1170A and G1316C (valve or 
column hosts) and G1316A/B and G7130A 

See 
Valve-Thermostat 
Cluster in the LC 
Driver Release Notes

Product 
Number

Module Name Minimum Firmware 
Revision

G1314A 1100 Series Variable Wavelength Detector A.06.10 

G1314B 1200 Series Variable Wavelength Detector A.06.10 

G1314C 1200 Series Variable Wavelength Detector A.06.10 

G1314D 1200 Series Variable Wavelength Detector B.06.32

G1314E 1290 Infinity Variable Wavelength Detector B.06.32

G1314F 1260 Infinity Variable Wavelength Detector B.06.32

G1315A 1100 Series Diode Array Detector A.06.10 

G1315B 1200 Series Diode Array Detector A.06.10 

G1315C 1200 Series Diode Array Detector VL+ B.06.30 

G1315D 1200 Series Diode Array Detector VL B.06.30 
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G1321A 1100 Series Fluorescence Detector (FLD) A.06.10

G1321B 1260 Infinity Fluorescence Detector A.06.32

G1321C 1260 Infinity Fluorescence Detector A.06.54

G1362A 1260 Infinity Refractive Index Detector A.06.10

G1365A 1100 Series Multiple Wavelength Detector A.06.10 

G1365B 1100 Series Multiple Wavelength Detector A.06.10 

G1365C 1260 Infinity Multiple Wavelength Detector B.06.30 

G1365D 1260 Infinity Multiple Wavelength Detector VL B.06.30 

G4212A 1290 Infinity Diode Array Detector B.06.30 

G4212B 1260 Infinity Diode Array Detector B.06.30 

HDR-DAD 
Cluster 

2x G4212A, 2x G4212B, 2x G7117A or 2x G7117B, or
a combination of either 1x G4212A and 1x G4212B, or 1x 
G7117A and 1x G7117B

B.06.57

G7114A 1260 Infinity II VWD D.07.01

G7114B 1290 Infinity II Variable Wavelength Detector D.06.70

G7115A 1260 Infinity II DAD WR D.07.01

G7117A 1290 Infinity II Diode Array Detector D.06.70

G7117B 1290 Infinity II Diode Array Detector FS D.06.70

G7117C 1260 Infinity II DAD HS D.07.01

G7121A 1260 Infinity II FLD D.07.01

G7121B 1260 Infinity II FLD Spectra D.07.01

G7162A 1260 Infinity II Refractive Index Detector D.06.76

G7162B 1290 Infinity II Refractive Index Detector D.06.76

G7165A 1260 Infinity II MWD D.07.01

ELSD

G4260A 380-ELSD 25.00

Product 
Number

Module Name Minimum Firmware 
Revision
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Agilent LC – Valve Solutions

G4261A 385-ELSD 25.00

G4260B 1260 Infinity ELSD 31.06

G4261B 1290 Infinity ELSD 31.06

G7102A 1290 Infinity II ELSD 31.06

Product 
Number

Module Name Minimum Firmware 
Revision

G1156A 1200 Series 6 Position / 7 Port Valve (400 bar) A.06.02

G1157A 1200 Series 2 Position / 10 Port Valve A.06.02

G1158A 1200 Series 2 Position / 6 Port Valve A.06.02

G1158B 1200 Series 2 Position / 6 Port Valve (600bar) A.06.02

G1159A 1200 Series 6 Position Selection Valve A.06.02

G1160A 1100 Series Multiple Purpose Switching Valve
(12 Position / 13 Port)

A.06.02

G1162A 1200 Series 2 Position/ 6 Port Micro Valve A.06.02

G1163A 1200 Series 2 Position/ 10 Port Micro Valve A.06.02

G1170A 1290 Infinity Valve Drive 1

1 A host may be required. For details see latest driver release note.

B.06.40

G4227A 1290 Infinity Flexible Cube 1 B.06.52 

G1390B UIB II B.06.53

Product 
Number

Module Name Minimum Firmware 
Revision
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Product 
Number 

Module Name Minimum 
Firmware 
Revision

G4286A 1120 Compact LC, Isocratic B.06.50

G4286B 1220 Infinity LC System Isocratic, Man. Inj., VWD, 600 bar B.06.50

G4287A 1120 Compact LC, Isocratic with Oven and ALS B.06.50

G4287B 1220 Infinity LC Isocratic, ALS, TCC, VWD, 600 bar B.06.50

G4288A 1120 Compact LC, Gradient B.06.50

G4288B 1220 Infinity LC Gradient, Man. Inj., VWD, 600 bar B.06.50

G4289A 1120 Compact LC, Gradient with Oven B.06.50

G4289B 1220 Infinity LC Gradient, ALS, TCC, VWD, 600 bar B.06.50

G4290A 1120 Compact LC,Gradient with oven and ALS B.06.50

G4290B 1220 Infinity LC Gradient, ALS, Man. Inj., TCC, VWD, 600 bar B.06.50

G4291B 1220 Infinity LC Isocratic, Man. Inj., TCC, VWD, 600 bar B.06.50

G4292B 1220 Infinity LC Isocratic, ALS, VWD, 600 bar B.06.50

G4293B 1220 Infinity LC Gradient, ALS, VWD, 600 bar B.06.50

G4294B 1220 Infinity LC Gradient, ALS, TCC, DAD, 600 bar B.06.50

G4286C 1220 Infinity LC System VL, Isocratic, Man. Inj., VWD, 400 bar B.06.50

G4287C 1220 Infinity LC System VL, Isocratic, ALS, TCC, VWD, 400 bar B.06.50

G4288C 1220 Infinity LC System VL, Gradient, Man. Inj. VWD, 400 bar B.06.50

G4289C 1220 Infinity LC System VL, Gradient, Man. Inj. VWD, 400 bar B.06.50

G4290C 1220 Infinity LC System VL, Gradient, ALS, TCC, VWD, 400 bar B.06.50

G4291C 1220 Infinity LC System VL, Isocratic, Man. Inj. TCC, VWD, 400 bar B.06.50

G4292C 1220 Infinity LC System VL, Isocratic, ALS, VWD, 400 bar B.06.50

G4293C 1220 Infinity LC System VL, Gradient, ALS, VWD, 400 bar B.06.50
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Agilent LC/MS

Recommended Firmware
Always use the most recent Firmware installation package that comes with 
the driver package.

Agilent LC/MS Single Quad 6100 Series
The following Agilent LC/MS instruments can be controlled with OpenLAB 
CDS. 

Product 
number

Description Note

G6120C
G6125C
G6130C
G6135C

MS Module
LC/MSD
MS Module
LC/MSD XT

61x0B to 61x0C via upgrade kit 
(G2725N)
61x5B to 61x5C via upgrade kit 
(G4934C)

G1947B
G1971B

APCI
APPI (Photo Ionization)

ESI or AJS capable source required

G1948B ESI

G1978B Multimode Source

G1958B Agilent Jet Stream for Single Quad
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Agilent GC and GC/MS

Agilent GC
Agilent recommends using the latest firmware revision in order to provide the 
highest level of system capability.

The tables below list the firmware used during the last software tests. 
Upgrading firmware to this version is not required in all cases. A firmware 
upgrade should be done if you face problems or want to add system capability 
to your GC. Refer to latest Hardware Service Notes for latest firmware 
available.

Supported GC Systems

Product 
Number

Description Firmware Revision

G3950A 
G3952A 
G3953A

Intuvo 9000 GC system A.01.01

G3440A
G3445A

7890A A.01.16

G3440B
G3445B

7890B B.02.04.2

G4350A 7820A A.01.17.004

G1530N
G1540N

6890N N.06.07

G1530A
G1540A

6890A
6890Plus

A.03.08

G2630A 6850
Serial # >= US10243001
Serial # < US00003200

A.06.02
A.03.07

G3581A 490 Micro GC 3.32
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Supported Autosamplers

Table 10 Agilent GC Autosampler

Model 
number

Description Firmware Revision

G4513A 7693 Injector A.10.09

G4514A Tray A.10.16

G4515A BCR/Mixer A.10.05

G4516A ALS Controller Board for 6890 Plus GC A.01.07

G4517A ALS Controller for 6890A GC A.01.07

G2912A 7683B ALS Controller for 6890 A.02.01

G2613A 7683A Injector A.10.07

G2913A 7683B Injector A.11.03

G2614A Tray A.02.01

G2615A BCR/Mixer n/a

G4567A 7650A ALS Injector A.10.02

G2880A 6850 ALS Injector A.10.05

Table 11 Agilent Headspace Autosampler

Product 
number

Description Firmware Revision

G4556A
G4557A

7697A Headspace A.01.07.1

G1888A
G1888 Headspace

A.01.10
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Table 12 Agilent CTC and PAL-xt CTC Sampler with Agilent GC

Product 
number

Description Firmware Revision

G6500-CTC CTC Combi-Pal for Liquid and Headspace 
Injection 

Agilent 2.6.8 or 4.3.0

G6501-CTC CTC Combi-Pal for Liquid Injection Agilent 2.6.8 or 4.3.0

G6509-CTC CTC Combi-Pal for Liquid Injection Agilent 2.6.8 or 4.3.0

G6502-CTC CTC GC-Pal for Liquid Injection Agilent 2.6.8 or 4.3.0

G6501B Agilent GC Sampler 80 for Liquid Injection 4.3.0

G6502B Agilent GC Injector 80 for Liquid Injection 4.3.0

G6509B Agilent GC Sampler 120 for Liquid Injection 4.3.0

Table 13 Agilent CTC PAL-3 Autosampler with Agilent GC

Product 
number

Description Firmware Revision

G7366A PAL RTC 120 Robotic Tool Change X-rail 2.2.3

G9256A PAL RSI 120 Robotic Sample Injection X-rail 2.2.3

G7368A PAL RSI 53 Robotic Sample Injection X-rail 2.2.3

G7370A PAL LSI 53 Liquid Sample Injection X-rail 2.2.3
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Recommended Firmware
Always use the most recent MS Firmware installation package that comes with 
the driver package.

Agilent GC/MS Single Quad Series
The following GC/MS Models can be controlled with OpenLAB CDS.

Model 
number / 
series

Description Note

5975A
5975B
5975C
5975E
5977A
5977E

MS System EI/CI

5977B MS System HES and EI/CI supported 

7890A
7890B
7820
6890N
6850

GC System GC's supported as part of 
GC/MS system - see 
“Supported GC Systems” on 
page 139 for details

7693
7683B
7650

GC ALS Samplers supported as part of 
GC/MS system - see 
“Supported Autosamplers” on 
page 140 for details

PAL-XT
PAL-3

CTC

G7697A
G1888

Headspace
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Other Agilent instruments or modules that you can connect with the latest 
revision of OpenLAB CDS:

Third Party Instruments
The following Non-Agilent Instruments can be controlled with OpenLAB CDS 
2.2. 

Table 14 Other Agilent modules

Product number Description

35900E
35900E (Series II)

35900 A/D Interface E.01.02
E.02.04

SS420x A/D Interface

7667A Mini Thermal Desorber

NOTE Download the most recent instrument drivers available from SubscribeNet to control 
non-Agilent Instruments.

Table 15 Drivers for non-Agilent instruments compatible with OpenLAB CDS 2.2

Part Number 3rd Party Vendor Driver Type Instrument Name Driver Version

M8505BA Waters LC Acquity and Acquity H-Class A.1.2

M8505BA Waters LC Waters Alliance 2690, 
Waters Alliance 2695,
e-Alliance e2695,
Waters 996 PDA,
Waters 2996 PDA,
Waters 2487 UV, 
Alliance 2489 DWD, 
Alliance 2998 PDA

6.1.4 

M8237BA Scion / Bruker/ 
Varian

GC 430/436
450/456
CP3800, CP3900, and associated Auto-samplers

A.02.02
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M8240BA Shimadzu LC LC-20 (Prominence), 
LC-30 (Nexera), 
LC-2030 (Prominence-i),
LC-2040 (Nexera-i), 
SPD-M20A/SPD-M30A

V1.41

M8232BA Shimadzu GC GC 2010,GC 2014, 
GC 2010 Plus, 
GC-2014C,
HS-10,
HS-20

V1.10

M8224BA Valco 
Instruments 
(VICI) 

Valve EMHCA-CE (High Speed), 
EMHA-C (Two Position), 
EMTCA-C (High Torque)

A.01.01

M8236BA Thermo Fisher LC Accela, Surveyor 4.1.4.28 

M8241BA Thermo Fisher GC Focus GC,
Trace GC Ultra,
Trace 1300/1310 plus samplers (TriPlus 
AS,TriPlus RSH, TriPlus 300 HS, TriPlus 100 LS, 
AI-1310, AS-1310)

Expected 
availability 
within 2017 1

Hitachi LC ChromasterUltra Rs, 
Chromaster,
Primaide

Expected 
availability 
within 2017 1

PerkinElmer GC Clarus 400/480/500/580/600/680 Expected 
availability 
within 2017 1

1 For further information, please contact your local Agilent Sales representative

Table 15 Drivers for non-Agilent instruments compatible with OpenLAB CDS 2.2

Part Number 3rd Party Vendor Driver Type Instrument Name Driver Version
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Incompatible Instruments and Modules
The following tables summarize selected instruments or modules that can not 
be controlled with the current revision of OpenLAB CDS.

Incompatible LC and LC/MS Modules

Incompatible CE Instruments
OpenLAB CDS 2.2 can not be used to control CE Instruments.

Product Number Module Name

G1364A-D Fraction Collector / Fraction Cluster

G5664A Bio-inert Fraction Collector

G1377A High Performance Micro Autosampler

G1389A Micro Thermostatted Autosampler

G2258A Dual-Loop Autosampler

G2260A Preparative Autosampler (High flow)

G7157A 1260 Infinity II Prep Sampler 

G1376A 1200 Micro Capillary Pump

G2226A 1200 Nanoflow Pump

G1361A 1200 Preparative Pump 

G7161A 1260 Prep Pump

G4218A Evaporative Light Scattering Detector

G1390A UIB

G4240A Chip Cube Source

6120B, 6125B
6130B, 6135B
6150B

LC/MS Single Quad modules
6120B, 6125B, 6130B and 6135B systems are supported after upgrade 
with Smart Card product (G2735N)
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Incompatible GC and GC/MS Instruments

Product Number Instrument Name

4890D GC system

5890 5890A GC system
5890 Series II GC system

G1176A 6820 GC system

G1180A 6820 GC system

G2629A 6850 Handheld Controller

G3581A 3000 Micro GC, M200, M400

19405A/B Sampler Event Control Module (SECM)

18593A
18594A
18596A

7673A GC Autosampler family

18593B
18594B
18596B

7673B GC Autosampler family

G1512A
G1513A
18596C

7673C GC Autosampler family

7694A Headspace

G1289A
G1290A
G1883A

Headspace

G8130A Workbench Tray

G7361A Archon Purge and Trap Auto sampler for Needle Sparge

G7360A Archon Purge and Trap Auto sampler for Water only

G5975T Integrated GC/MS

G1926A Barcode Reader

G4557A Barcode Reader for 111 vial, not supported on 12 vial

G2403A LAN/RS232 converter Dudley box

G2629A 6850 Handheld Controller
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Software Compatibility

This chapter contains information on compatibility with other Agilent or 
Non-Agilent Software.

Agilent Software
The following Agilent software is compatible with version 2.2 of OpenLAB 
CDS:

• LabAdvisor for LC

• Instrument Utilities for GC

• ACE

• Remote Advisor

• Sample Scheduler 2.0 for OpenLAB CDS

• OpenLAB ELN

• Match Compare
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Libraries and Databases
The following libraries and databases are compatible with version 2.2 of 
OpenLAB CDS:

Thoroughly tested:

• NIST MS Search/ NIST Library, Revision 2.2 / NIST14

This library ships with NIST MS Search

Functionally tested libraries are:

• NIST MS Search/ NIST Library revisions:

• 2.0g / NIST11

• 2.0f / NIST08 NIST Functionally tested PLLI 

• 2.0f / NIST08Demo

• Wiley/NIST Combined MS Library revisions:

• W10N14

Ships with the NIST MS Search appropriate to the NIST version (N), e.g. 
W10N14 contains MS Search v2.2.

• W10N14

• W10N11

• W9N08

• Other libraries of NIST format:

Any library in the appropriate NIST format, can be opened in NIST MS 
Search and a basic search e.g. name search, run against it.
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Privileges in the Control Panel

The privileges described in the following can be associated with different roles 
in the Control Panel. The following roles are available:

In the Control Panel under Administration > Roles, you can view or change the 
associated privileges, or create your own roles.

Project Privileges

Everything Instrument User

System Administrator Technician

Instrument Administrator Chemist

Project Administrator

Table 16 Project Management

Name Description

Manage project or project group User can create or edit project properties and 
can move the project but cannot view or edit 
the project access settings.

Manage project or project group access User can view and edit the project access 
settings.

View project or project group User can see a project and project details but 
cannot edit.
Note: This privilege is required for all users.

Access content using web client User can view the data via the Content 
Management web interface.

Edit content of project User can create new versions of documents 
(e.g. data, methods, or templates).
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Table 17 E-Signature

Name Description

E-Signature Sign Data Files User can sign data files

Revoke E-Signature User can revoke the e-signature.

Table 18 Sample Prep

Name Description

Create and modify sample prep View, edit, and save an autosampler sample 
prep file

Table 19 Acquisition Method

Name Description

Create and modify acquisition method Create, edit and save an acquisition method file 
(*.amx)

Table 20 Processing Method

Name Description

Create processing method Create a new processing method (*.pmx), or 
save a method under a new name.

Save master method Save changes to a processing method in the 
Methods folder.

Save result set method Save changes to a processing method in the 
result set folder.

Edit sample information Edit information in the Injection List window.

Edit integration parameters View and edit the parameters in the 
Integration Events section of a method.

Edit method override parameters Override parameters in a predefined acquisition 
method.
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Edit identification parameters View and edit the parameters in the 
Compounds > Identification section of a 
method.

Edit chromatogram extraction parameters View and edit the parameters in the Extraction 
> Chromatogram section of a method.

Edit spectrum extraction parameters View and edit the parameters in the Extraction 
> Spectrum section of a method.

Edit MS library search parameters View and edit the parameters in the MS 
Library Search > Properties section of a 
method.

Edit calibration parameters View and edit the parameters in the 
Compounds > Calibration section of method.

Edit spectra parameters View and edit the parameters in the 
Compounds > Spectra section of method.

Edit system suitability parameters View and edit the parameters in the 
Compounds > System Suitability section of 
method.

Edit custom calculation parameters View and edit the parameters in the Tools > 
Custom Calculation section of a method.

Edit signal parameters View and edit the parameters in the General > 
Signals section of a method.

Edit sample purity parameters View and edit the parameters in the MS 
Sample Purity section of a method.

Edit reporting parameters View and edit the parameters in the Reports > 
Injection Report section of a method.

Edit general parameters View and edit the parameters in the General > 
Propertiess section of a method.

Load older master method With Content Management, load an older 
version of a master method.

Table 20 Processing Method

Name Description
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Table 21 Report Template

Privilege Description

Unlock/lock report template items Lock and unlock report template items (tables, 
chromatograms, groups of items, ...) to control 
who is allowed to modify those.

Validate report template Confirm usage of report templates that have 
been modified outside OpenLAB CDS.

Create report template Create and edit report templates in the 
Reporting view.

Table 22 Sequence Template

Name Description

Create and modify sequence template Create, edit and save sequence creation 
templates (*.stx).

Table 23 Sequence

Name Description

Edit any users running sequence Edit any user's running sequence (status 
Acquiring in the Run Queue).

Create and modify sequence Create, edit and save sequences (*.sqx)

Edit users own running sequences Edit your own running sequences (status 
Acquiring in the Run Queue).

Table 24 Audit Trail

Name Description

Change method audit trail settings Edit and save method audit trail settings 
(project properties in the Control Panel).

Review audit trail Confirm that you reviewed a changed audit 
trail.

Add manual audit trail entry Add a manual entry to document your own 
actions in the audit trail.
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Table 25 Control

Name Description

Abort any running sample Abort any running sequence or single run.

Manual control (in run) Access manual control functions while the 
instrument is running.

Manual control (only when instrument idle) Access manual control functions while the 
instrument is idle.

MS autotune and manual tuning Access all MS tune and maintenance 
functionality, including manual tune, autotune, 
and check tune.

Delete any pending run Remove pending runs from the Run Queue.

MS autotune Perform MS autotune and check tune.

Table 26 Data Processing

Name Description

Reprocess data Reprocess injections or result sets.

Do manual compound identification Manually assign a compound to a peak.

Do manual integration Activate manual integration in the 
Chromatograms window.

Do manual chromatogram extraction Manually extract UV wavelength 
chromatograms or MS (TIC-SIM/TIC-SCAN) 
chromatograms from your data.

Do manual spectrum extraction Manually extract UV or MS spectra from your 
data.

Do manual MS library search Manually search for matches in an MS library.

Update master processing method Save changes from a result set method to the 
corresponding master processing method in 
the Methods folder.

Create new result set Combine single samples or sequences from 
different sources in a new, self-assembled 
result set.
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Print results reports Create reports for your methods or results.

Launch Custom Calculation Editor Start the Custom Calculation Editor from Data 
Analysis.

Table 27 File and Folder Operations

Name Description

Delete report templates Delete report templates (*.rdl) in the Data 
Selection view of Data Analysis.

Delete sequence templates Delete sequence templates (*.stx) files in the 
Data Selection view of Data Analysis.

Delete methods Delete processing methods (*.pmx) or 
acquisition methods (*.amx) in the Data 
Selection view of Data Analysis.

Table 28 Data

Name Description

Export data Export data into an OpenLAB archive (*.olax).

Import data Import data from OpenLAB archives (*.olax) 
into the OpenLAB system.

Save reports to disk Save or export a report to a location on a disk 
or network share.

Table 29 Lock

Name Description

Lock Results Lock a result set to protect it from being 
changed.

Unlock Results Unlock a locked result set.

Table 26 Data Processing

Name Description
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Instrument Privileges

Table 30 Custom Tools

Name Description

Access Custom Tools section Start external programs that were added to the 
application via the customization tool

Table 31 Snapshot

Name Description

Review snapshot results From Acquisition, open a currently running 
sample in Data Analysis.

Table 32 Instrument Management

Name Description

View instrument or location User can view and access a location in the 
tree, but not edit access security, can view 
properties.

Manage Instrument or location User can create and move locations and edit 
properties (name, description, etc).

Manage instrument or location access User can view and edit the location access 
settings.

Run instrument User can start an instrument session.

Service instrument User can lock or unlock an instrument (to 
service it).
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Administrative Privileges
Table 33 System Administration

Name Description

Manage printers Can add/remove printers and print server. 

Edit activity log properties Can change the Activity log Settings in the 
Control Panel (that is, can turn logging on for 
the System Activity Log).

Create administrative reports Can create any of the system admin reports. 

Manage system components Can install/remove components (applications).

Manage security Can change security settings and assign 
security roles.
Can edit (add, change etc) users, groups and 
roles.
Can move and delete files and folders in the 
Content Management database.
Note: A user with this privilege can grant 
himself access to all settings in Shared 
Services. Be careful who you grant the Manage 
Security privilege.

Manage instrument controllers Can edit Instrument Controllers in the Control 
Panel.

Unlock any locked UI Can log in to another user's locked session.
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Sales and Support Assistance

Please check the following web site for your local sales and support contact:

http://www.agilent.com/en-us/contact-us/page
OpenLAB CDS Workstation 157



www.agilent.com
In This Book

This document provides instructions for 
installation, configuration, administration, and 
maintenance of an OpenLAB CDS Workstation. 
It includes information on the license 
generation with SubscribeNet.

The manual describes the following:

• Install OpenLAB CDS Workstation with 
Local File System

• Generating and Downloading Your Software 
License

• Configure OpenLAB CDS Workstation

• Optional Procedures

• Customization

• About the OpenLAB CDS software

• System Setup and Maintenance
© Agilent Technologies 2016-2017

Printed in Germany 
06/2017

*M8413-90002*
*M8413-90002*
M8413-90002

Agilent Technologies


	In this Guide ...
	1 Install OpenLAB CDS Workstation
	Installation Workflow Overview
	Before you Begin
	Run the OpenLAB Installer
	Silent Installation
	Export Properties File
	Run Installation
	Parameters and Return Codes
	Logging and Tracing

	Install or Upgrade Driver Software
	Register driver software with OpenLAB CDS


	2 Post Installation Tasks
	Set Account to Enable Automatic Printing
	Configure the Antivirus Program
	Configure Internet Explorer for OpenLAB Help and Learning
	Local Windows Account for Secure Projects Root Folder
	Disable Windows 10 Updates

	3 Licensing
	About OpenLAB CDS Licensing
	Software subscriptions and Software Maintenance Agreement (SMA)
	License Types
	License File

	Get a License
	Obtain a License with SubscribeNet
	Other Ways to Obtain a License

	Install Your License

	4 Configure OpenLAB CDS Workstation
	Configure Authentication
	Configure Security Policy
	Configure users, roles, and privileges
	Create or import users
	Groups
	Roles and Privileges
	Add users or groups to a role
	Specific Roles for Individual Instruments or Projects

	Configure the Storage Location
	Enable File System Security
	Configure Initial Project
	Configure Initial Instrument
	Other settings in the Control Panel

	5 Optional Procedures
	Install OpenLAB Help and Learning Only
	Improve Performance on Offline Machines

	6 About the OpenLAB CDS Software
	Software Architecture
	Local File System

	Customization
	Customization via custom calculations
	Customization via report templates
	Customize application to start external programs


	7 System Setup and Maintenance
	Control Panel
	Instrument Management / Lab Status at a Glance
	License Management
	System Activity Log
	Diagnostics
	Administrative Reports
	Authentication Provider
	Security Policy
	User Management

	Shared Services Maintenance
	Maintenance Procedures
	Introduction
	Software backup procedure
	Data Backup Procedure
	Software Restore Procedure
	Data Recovery Procedure


	8 Upgrade OpenLAB CDS
	License Upgrade
	Get Upgraded License File
	Add Upgraded License File to the System

	Upgrade OpenLAB CDS Workstation to Latest Version

	9 Uninstall OpenLAB CDS With All of its Components
	Uninstall OpenLAB CDS
	Uninstall OpenLAB Help and Learning Only

	10 Appendix
	Hardware and Software Requirements
	General Software Requirements
	Language Compatibility
	Disk Space
	Hardware
	Number of Instruments
	Software

	Network Requirements
	Introduction
	LAN Connectivity

	Operating System Configuration
	Configure Windows 10
	Configure Windows 8.1
	Configure Windows 7

	Instrument Connections
	RC.NET Drivers compatible with OpenLAB CDS
	Agilent LC and LC/MS
	Agilent GC and GC/MS
	Other supported Agilent Instruments
	Third Party Instruments
	Incompatible Instruments and Modules

	Software Compatibility
	Agilent Software
	Libraries and Databases

	Privileges in the Control Panel
	Project Privileges
	Instrument Privileges
	Administrative Privileges

	Sales and Support Assistance

	In This Book

